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Notices

© Agilent Technologies, Inc. 2006

No part of this manual may be reproduced
in any form or by any means (including
electronic storage and retrieval or transla-
tion into a foreign language) without prior
agreement and written consent from Agi-
lent Technologies, Inc. as governed by
United States and international copyright
laws.

Manual Part Number
N9320-90001

Edition
Second Edition, July. 2007
Printed in China

Agilent Technologies, Inc.

Hi-Tech Industrial Development Zone (West
District)

Chengdu 611731, P.R.C

Software Revision

This guide is valid for A.02.00 revisions of
the Agilent N9320A Spectrum Analyzer
software.

Warranty

The material contained in this docu-
ment is provided “as is,” and is sub-
ject to being changed, without notice,
in future editions. Further, to the max-
imum extent permitted by applicable
law, Agilent disclaims all warranties,
either express or implied, with regard
to this manual and any information
contained herein, including but not
limited to the implied warranties of
merchantability and fitness for a par-
ticular purpose. Agilent shall not be
liable for errors or for incidental or
consequential damages in connection
with the furnishing, use, or perfor-
mance of this document or of any
information contained herein. Should
Agilent and the user have a separate
written agreement with warranty
terms covering the material in this
document that conflict with these
terms, the warranty terms in the sep-
arate agreement shall control.

Technology Licenses

The hardware and/or software described in
this document are furnished under a
license and may be used or copied only in
accordance with the terms of such license.

Restricted Rights Legend

U.S. Government Restricted Rights. Soft-
ware and technical data rights granted to
the federal government include only those
rights customarily provided to end user cus-
tomers. Agilent provides this customary
commercial license in Software and techni-
cal data pursuant to FAR 12.211 (Technical
Data) and 12.212 (Computer Software) and,
for the Department of Defense, DFARS
252.227-7015 (Technical Data - Commercial
Items) and DFARS 227.7202-3 (Rights in
Commercial Computer Software or Com-
puter Software Documentation).

Safety Notices

A CAUTION notice denotes a haz-
ard. It calls attention to an operat-
ing procedure, practice, or the like
that, if not correctly performed or
adhered to, could result in damage
to the product or loss of important
data. Do not proceed beyond a
CAUTION notice until the indi-
cated conditions are fully under-
stood and met.

A WARNING notice denotes a
hazard. It calls attention to an
operating procedure, practice, or
the like that, if not correctly per-
formed or adhered to, could result
in personal injury or death. Do not
proceed beyond a WARNING
notice until the indicated condi-
tions are fully understood and
met.
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In This User’s Guide...

N9320A Spectrum Analyzer

This guide contains operation information for the N9320A
Spectrum Analyzer.

Overview
A quick overview of the front and rear panels.

Getting Started
Unpacking and setting up your analyzer.

Functions and Measurements
How to use the analyzer in the basic applications.

Key Reference
Describe every front- panel hardkeys and the related softkeys
functions in detail.

’

One-Button Measurements
Describe the key definition of one-button measurement.

Instrument Messages
This chapter give the instrument messages of the analyzer.

In Case of Difficulty

This chapter provides some information and tips when you
met some difficulties.

Menu Maps
The overall list of the menu structure maps.

For more information about N9320A Spectrum Analyzer, see
www.agilent.com/find/n9320a.
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This chapter describes the general features and functions of
the Agilent N9320A spectrum analyzer and provides an
introduction of the front and rear panels.
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1 Overview

Agilent N9320A at a Glance

An Agilent N9320A spectrum analyzer is a swept portable
spectrum analyzer with a frequency range of 9 kHz to

3.0 GHz. It can be a fundamental component of an
automated system, and be widely used in electronic
manufacturing functional/final/QA test systems.

An Agilent N9320A spectrum analyzer provides features and
functions as below:

* High sensitive measurement

The spectrum analyzer includes a pre-amplifier for signal up
to 3 GHz, enabling highly sensitive measurements. This helps
in analysis of weak signals.

» Pass/fail limits

Upper and lower limits can be set on the screen, thereby
enable the user to make PASS/FAIL judgments on trace data.

* Four-trace detection display

The spectrum analyzer displays up to four independent
traces simultaneously.

» SSB Phase Noise Measurement

The analyzer provides the automatic single-sideband phase
noise measurement capability (dBc/Hz). The display includes
frequency offset and the noise value.

* Frequency counter with 0.1 Hz resolution

The built-in counter allows the user to measure the signal
frequency with 0.1 Hz resolution.

» USB interface

Using this interface allows the operator to save and transfer
a screen shot (in JPG format) to a USB storage device. This
feature enables measurement data to be gathered and pasted
into reports in a PC environment.

2 N9320A Spectrum Analyzer



Front Panel Overview
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This section provides the information of the front panel.
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Screen shows information of the current function, including
the signal traces, status indicators, and instrument messages.
Labels for softkeys are located on the right-hand side of the
screen.

Softkeys are the unlabeled keys next to the screen. They
activate functions displayed to the left of each key.

Amplitude activates the reference level function and
accesses the amplitude softkeys, with which you set
functions that affect data on the vertical axis.

SPAN sets the frequency range symmetrically about the
center frequency. The frequency-span readout describes the
total displayed frequency range.

Frequency activates the center-frequency function, and
accesses the menu of frequency functions.

Function keys relate directly to the following main functions:
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¢ Preset/System (Local) accesses the softkeys to reset the
analyzer to a known state, if the analyzer is in the remote
mode, pressing this key returns the analyzer to the local
mode and enables front-panel control.

¢ Auto Tune search the signal automatically and locate the
signal to the center of the graticule. see “Auto Tune” on
page 73.

e BW/Avg activates the resolution bandwidth function and
accesses the softkeys that control the bandwidth functions
and averaging.

e Sweep/Trig accesses the softkeys that allow you to set the
sweep time, select the sweep mode and trigger mode of
the analyzer.

e View/Trace accesses the softkeys that allow you to store
and manipulate trace information.

e Det/Display accesses the softkeys that allow you to
configure detector functions and control what is displayed
on the analyzer, including the display line as well as the
testing of trace data against entered limits.

e MODE selects the measurement mode of your analyzer.

e Meas accesses the softkeys that let you make transmitter
power measurements such as adjacent channel power,
occupied bandwidth, and harmonic distortion, etc. Please
refer to “One-Button Measurements” on page 117.

e Marker accesses the marker control keys that select the
type and number of markers and turns them on and off.

e Marker-> accesses the marker function softkeys that help
you with the measurement.

¢ Peak Search places a marker on the highest peak.
¢ File/Print accesses the softkeys that allow you to
configure the file and printing system of the analyzer.

Data Control Keys including the arrow keys, back key, Enter
key, knob, and numeric keypad, change the numeric value of
an active function such as center frequency, start frequency,
resolution bandwidth, and marker position.

N9320A Spectrum Analyzer
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RF IN connector is the signal input for the analyzer. The
maximum damage level is average continuous power
+40 dBm, DC voltage 50 VDC. The impedance is 50 Q.
(N-type female).

PROBE POWER connector provides power for high-impedance
AC probes or other accessories (+15 V, —-12 V, 150 mA
maximum).

CAL OUT connector provides an amplitude reference signal
output of 50 MHz at -10 dBm (BNC female).

TG SOURCE connector N-type female, is the source output for
the built-in tracking generator. The impedance is 50 Q. (for
Option TG3)

If the tracking generator output power is higher than the maximum power
that the device under test can tolerate, it may damage the device under
test. Do not exceed the maximum power of DUT.

Standby Switch switches on all functions of the analyzer. To
switch the analyzer off, press the switch for at least 2
seconds. This deactivates all the functions but retains power
to internal circuits so long as the analyzer is connected to
line power.

On LED (green) lights when the analyzer is switched on.

Standby LED (orange) lights when the analyzer is connected
to the line power.

Remote LED (red) lights when the analyzer is remotely
controlled by a PC via the USB host interface on the rear
panel.

USB connector (DEV) provides a connection between external
USB devices and the analyzer, such as a USB memory
device.
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Display Annotations

-1N.00 dBn

Atten 10 dB

ExtRef  Remote

1.000000 MHz

Full Span

Zero Span

Last Span

Description

Notes (Associated function key)

Amplitude scale

[Amplitude] > Scale Type

Detector mode

[Det/Display] > Detector

Reference level

[Amplitude] > Rel Level

Active function block

The function in use

Time and date display

[Preset/System] > Time/Date

RF attenuation

[Amplitude] > Attenuation

Marker frequency

[Marker] or
[Marker] > Function > Frequency Counter

Uncal indicator

The readout of amplitude is uncalibrated.

Marker amplitude

[Marker]

10

External reference

An external frequency reference is in use.

"

Remote mode

The analyzer is in remote mode

12

Key menu title

Dependent on key selection.

N9320A Spectrum Analyzer
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13 Softkey menu Refer to “Key Reference” for details.
14 Frequency span [SPAN]
15 Sweep time [Sweep/Trig] > Sweep Time
16 Video bandwidth [Bw/Avg] > Video BW
17 Display status line Display status and instrument messages.
18 Resolution bandwidth [Bw/Avg] > Res BW
19 Center frequency [Frequency] > Center frequency
20 Continuous peak [Peak Search] > Continuous pk
21 Signal track [Frequency] > Signal Track
22 Internal preamplifier [Amplitude] > Int Preamp
23 Trigger/Sweep [Sweep/Trig]
F - free run trigger
V - video trigger
E - external trigger
C - continuous sweep
S - single sweep
24 Trace mode [Trace]
W - clear write
M - maximum hold
m - minimum hold
V -view
S - store blank
25 Average [Bw/Avg] > Average On Off
VAvg - video average
PAvg - power average
26 Display line [Det/Display] > display Line On Off
27 Optimized Phase @ [Marker] > Function > Optimize Phase Noise

a. Optimized Phase is only available when SPAN doesn’t exceed 50 kHz.
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REF OUT connector provides a frequency of 10 MHz, amplitude
of —10 dBm reference output. (BNC female)

REF IN connector accepts an external timebase with a
frequency of 10 MHz, amplitude of -5 to +10 dBm (BNC
female).

Kensington Lock lock the instrument and keep its safety.

LAN port is reserved for future expansion.

EXT TRG IN (TTL) connector accepts an external voltage input,
the positive edge of which triggers the analyzer sweep
function (BNC female).

Power switch isolates the analyzer from the AC line power.
After switch on, the analyzer enters into standby mode and
the orange standby LED on the front panel lights.

AC power receptacle accepts a three-pin line power plug.

VGA connector provides the video output signal to an
external monitor or projector (D-sub 15-pin female).

USB Host connector provides a connection between the
analyzer and an PC for remote control.

N9320A Spectrum Analyzer
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Front and rear panel symbols

The instruction manual symbol: indicates that the user must refer to spe-
cific instructions in the manual.
c € The CE mark: a registered trademark of the European Community.
ISM1-A Shows that this is an Industrial Scientific and Medical Group 1 Class

A product. (CISPR 11, Clause 4)

<sp® The CSA mark: a registered trademark of the Canadian Standards
c US Association International.

The ISM device complies with Canadian Interference- Causing
ICES/NMB-001 Equipment Standard-001.
Cet appareil ISM est conforme a la norme NMB-001 du Canada.

Communication Media Authority. It indicates compliance with all

The C-Tick mark: a trademark registered to the Australian
0 N10149
Australian EMC regulatory information.

(I) I marks the “on/standby” position of the switch.

indicates that the instrument requires AC power input.

o
indicates this product complies with the WEEE Directive(2002/96/EC)
marking requirements and you must not discard this equipment in
domestic household waste. Do not dispose in domestic household
waste. To return unwanted products, contact your local Agilent office,
[ ] or refer to http://www.agilent.com/environment/product/

N9320A Spectrum Analyzer 9
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This chapter gives you the information to start using the
spectrum analyzer correctly.

Agilent Technologies
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2 Getting Started

Check the Shipment and Order List

After receiving the shipment, first check the shipment and
your order list according to the following procedure.

¢ Inspect the shipping container for damage.

Signs of damage may include a dented or torn shipping
container or cushioning material that indicate signs of
unusual stress or compacting.

¢ Carefully remove the contents from the shipping container
and verify that your order is complete. Each spectrum
analyzer includes the following items as standard:

Item Quantity  Part number

N9320A Spectrum Analyzer 1 N9320A

USB cable 1 8121-1515

N-BNC adapter 1 1250-0780

BNC cable 1 8120-2682

Three-pin power cord 1 Specific to shipping location
User’s Guide 1 N9320-90001

Help kit CD-ROM 1 N9320-84500

Calibration certificate 1 5962-0476

e Verify if that the shipment includes your ordered options
by checking the option label on the rear panel:

Option Name Part number
PA3 3 GHz Preamplifier N9320A-PA3
TG3 3 GHz Tracking Generator N9320A-TG3
1HB Handle and bumpers N9320A-1HB
1CM Rackmount kit N9320A-1CM
1TC Hard transit case N9320A-1TC

For any questions about your shipment, please Contact
Agilent Technologies for consulting and service.

12 N9320A Spectrum Analyzer



Power Requirements

Getting Started 2

The spectrum analyzer has an auto-ranging line voltage
input. The AC power supply must meet the following
requirements:

Voltage: 100 to 240 VAC (90 to 264 VAC)
Frequency: 50 to 60 Hz

Power: Maximum 100 W

AC Power Cord

N9320A Spectrum Analyzer

The analyzer is equipped with a three-wire power cord, in
accordance with international safety standards. This cable
grounds the analyzer cabinet when connected to an
appropriate power line outlet. The cable appropriate to the
original shipping location is included with the analyzer.

Various AC power cables are available that are unique to
specific geographic areas. You can order additional AC power
cables for use in different areas. The table AC Power Cords
lists the available AC power cables, the plug configurations,
and identifies the geographic area in which each cable is
appropriate.

The detachable power cord is the product disconnecting
device. It disconnects the mains circuits from the mains
supply before other parts of the product. The front panel
switch is only a standby switch and do not disconnect
instrument from LINE power.

13



2  Getting Started

AC Power Cords

Plug Type Cable Part Plug @ For use in
Number Description Country & Region
8121-1703 BS 1363/A Option 900

United Kingdom, Hong Kong,
Singapore, Malaysia

<

250V 10A

8120-0696 AS 3112:2000 Option 901

Australia, New Zealand

250V 10A

8120-1692 IEC 83 C4 Option 902

Continental Europe, Korea,

Indonesia, Italy, Russia
250V 16A

8120-1521 CNS 10917-2 Option 903

/NEMA 5-15P Unite States, Canada, Taiwan,
125V 10A Mexico
8120-2296 SEV 1011 Option 906
/ Switzerland
2 250V 10A
A 8120-4600 SABS 164-1 Option 917
South Africa, India
230V 15A
8120-4754 JIS C8303 Option 918
Japan
125V 15A
8120-5181 SI1 32 Option 919
& Israel
&
250V 16A
- 8120-8377 GB 1002 Option 922

China

250V 10A

a. Plug description describes the plug only. The part number is for the complete cable assembly.

14 N9320A Spectrum Analyzer



Getting Started

Environmental Requirements

Ventilation

Agilent Technologies has designed this product for use in
Installation Category II, Pollution Degree 2, per IEC 61010-1.
Agilent has designed the spectrum analyzer for use under
the following conditions:

e Indoor use

¢ Altitude < 3,000 meters

e Operating temperature range: +5 to +45 °C;
Storage temperature range: —20 to +70 °C

¢ Relative humidity range 15% to 95 %

Ventilation holes are located on the rear panel and one side
of the spectrum analyzer cover. Do not allow these holes to
be obstructed, as they allow air flow through the spectrum
analyzer.

When installing the spectrum analyzer in a cabinet, do not
restrict the convection of the analyzer. The ambient
temperature outside the cabinet must be less than the
maximum operating temperature of the spectrum analyzer by
4 °C for every 100 watts dissipated within the cabinet.

Cleaning Tips

N9320A Spectrum Analyzer

To prevent electrical shock, disconnect the spectrum analyzer
from line power before cleaning. Use a dry cloth or one
slightly dampened with water to clean the external case
parts. Do not attempt to clean internally.

15
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2 Getting Started

Rack Mount

You are recommended to rackmount kit (option 1CM) to
install the signal generator into a rack.

Do not attempt to rack mount the signal generator by the
front panel handles only. This rackmount kit allows you to
mount the signal generator with or without handles.

Refer to the following instructions when you want to
rackmount the signal generator.

1 Remove feet, key-locks and tilt stands.

2 Remove side trim strips and a middle screw per side.

SIDE TRIM

16 N9320A Spectrum Analyzer



Getting Started 2

3 Attach rackmount flange and front handle assembly with 3
screws per side.

FRONT HANDLE
ASSEMBLY

4 Rackmounting with two dress screws per side.

Installing the spectrum analyzers into other racks may promote shock
hazards, overheating, dust contamination, and inferior system
performance. Consult your Agilent customer engineer about installation,
warranty, and support details.

Transit

You are also recommended to use the hard transit case
(option 1TC) for instrument transportations.

N9320A Spectrum Analyzer 17
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Safety Notice

18

Please read the following warnings and cautions carefully
before you power on the spectrum analyzer to ensure your
personal and instrument safety.

Always use a well-grounded, three-pin AC power cord to connect to
power source. Personal injury may occur if there is any interruption of
the AC power cord. Intentional interruption is prohibited. If this product
is to be energized via an external auto transformer for voltage
reduction, make sure that its common terminal is connected to a
neutral (earthed pole) of the power supply.

Personal injury may result if the spectrum analyzer covers are removed.
There are no operator service parts inside. To avoid electrical shock,
refer servicing to qualified personnel.

Electrical shock may result if the spectrum analyzer is connected from
the power supply while cleaning. Do not attempt to clean internally.

Ensure protection of the input mixer by limiting average continuous power
input to +30 dBm, DC voltage to 50 VDC, maximum pulse voltage to 125V,
or it may result in instrument damage.

N9320A Spectrum Analyzer



Getting Started 2

Electrostatic Discharge Protection

N9320A Spectrum Analyzer

Electrostatic discharge (ESD) damages or destroys electronic
components (the possibility of unseen damage caused by
ESD is present whenever transportation, store or use of
components).

This product contains components that are easily damaged
by electrostatic discharge. To help reduce ESD damage that
can occur while using test equipment:

Before connecting any coaxial cable to the spectrum analyzer
connector for the first time each day, momentarily short the
center and outer conductors of the cable together.

Personnel should be grounded with a 1 MQ resistor-isolated
wrist- strap before touching the center pin of any connector,
and before removing any assembly from the spectrum
analyzer.

Be sure that all instruments are properly grounded to
prevent build-up of static charge.

For more information about ESD and how to prevent ESD
damage, contact the Electrostatic Discharge Association
(http.//www.esda.org). The ESD standards developed by this
agency are sanctioned by the American National Standards
Institute (ANSID).

19
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Power on and Check
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Getting Started

L0 = .

Connect the power cord. Insert the plug into a power socket
provided with a protective earth. Set the tilt adjustor for
your preference.

[l i)

Press the line switch on the rear panel. The standby LED
(orange) will light and the spectrum analyzer is in standby
mode.

Press the standby switch () on the front panel. The Line
LED (green) will light, and the spectrum analyzer boots up.

Self-initialization takes about 25 seconds; the spectrum
analyzer then defaults to the menu mode. After power on,
let the spectrum analyzer warm up for 45 minutes for
stabilization.

The front panel switch is a standby switch only; it is not a power
switch. To disconnect the spectrum analyzer from the line power, shut
off the power switch on the rear panel.

N9320A Spectrum Analyzer



Getting Started 2

Check for Instrument Messages

N9320A Spectrum Analyzer

The spectrum analyzer has two categories of instrument
messages: error and warning messages. A error message is
triggered by operation errors, for example, setting conflicts
or data input is out of the range of a parameter. An warning
message mainly is triggered by hardware defects which could
result in damage to instrument.

Here are some tips to check the instrument messages.

Check the display to see if any messages display in the
status bar. Press > More > Show Errors to review each
messages. Please refer to Chapter 6, “Instrument Messages”
for detailed system messages descriptions.

When you have reviewed and resolved all of the error
messages, press > More > Show Errors > Clear error queue to
delete the messages.

Cycle the power on the analyzer and then check again if the
Instrument messages is still there.

If you can not resolve all error messages, please contact
Customer Contact Center for service.

21



2 Getting Started

Some helpful Tips

Please refer to the following descriptions for your further
use, including alignment, external reference, firmware update
and option activation.

Running Internal Alignments

To meet specifications, the analyzer must be manually
aligned.

When the alignment runs, you will hear clicking as the attenuator
settings changing. This is not an indication of trouble.

Manually Performing an Alignment

1 Connect a BNC cable with N-BNC adapter between the CAL
OUT and RFIN connector.

2  After warm-up, press j > Alignment > Align > All.

Please refer to “Alignment” on page 109 for details.

Enable the Options

You are required to enter the option license key to enable
the option. Contact your nearest Agilent Office for
purchasing a license. Please refer to the procedures below to
activate the options you have purchased. (option TG3 and
option PA3)

1  Press ﬁ > More > More > Licensing > Option

2 Enter the option number which you want to enable, Press
[Enter] to confirm your input.

Press > More > More > Licensing > License key

4 Enter and terminate the license input. The option will be
enabled immediately.

22 N9320A Spectrum Analyzer



Getting Started 2

Using an External Reference

If you wish to use an external 10 MHz source as the
reference frequency, connect an external reference source to
the REFIN connector on the rear panel. An EXT REF
indicator will display in the upper bar of the display. The
signal level range is -5 to +10 dBm.

Firmware Revision

N9320A Spectrum Analyzer

Press T’E > More > Show software to view the firmware
revision of your analyzer. If you call Agilent Technologies
regarding your analyzer, it’s helpful to have this revision and
the analyzer serial number available. To update the
firmware, please refer to

http://www.agilent.com/find/n9320

Follow this procedure to finish the firmware update:

Download the firmware update package to the root directory
of your USB storage device. Do not put this package into
any other folders when updating.

Insert this USB storage device into the USB connector of
front panel.

Power on your spectrum analyzer, the instrument will
perform the update process automatically.

Any interruption during the update process will result in update failure
and system data lost. Do not remove the USB storage device until the
update is finished.

After this procedure, you will get your spectrum analyzer
with latest version firmware.

23



2  Getting Started

Remote Control

24

The N9320A spectrum analyzer provides USB connection to
your PC, allowing you run the analyzer in remote mode.

USB
cable

The configuration of setting up a remote control for your
N9320A is simple: connect your N9320A and PC which has
installed Agilent 10 Libraries Suite with a USB cable.

Connection Expert
Agilent IO Libraries Suite 14

www.agilent.com

spplication is starting...

";I:I::' Agilent Technologies
’ © Agilent Technologies 2005

When you connect your PC with the spectrum analyzer,
power on your spectrum analyzer, the PC detects if there is
a connection of the spectrum analyzer.

If you need the remote control more flexible, you can also
build up your own program by using the SCPI commands.

For more information about Agilent 10 Libraries Suite, refer
to http://www.agilent.com/find/iolib

For further information on remote control and programming,
please refer to the N9320A Programmer’s Guide in the
NI9320A Help Kit CD.

N9320A Spectrum Analyzer
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This chapter provides information on the functions and some
specified measurements of the spectrum analyzer.

We assume that you understand the front and rear panel
layout, and display annotations of your analyzer. If you do
not, please refer to “Agilent N9320A at a Glance” on page 2.

Agilent Technologies 25
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Making a Basic Measurement

26

In this guide, the keys labeled a [ ], for example,
[Preset/System] is front- panel hardkeys. Pressing most of the
hardkeys accesses menus of functions that are displayed
along the right side of the screen, for example, Preset Type.
These displayed functions are called softkeys.

Using the Front Panel

Knob
Arrow Keys

Numeric Keys

Unit Softkeys
Enter Key

Back Key

Toggle
Submenu
Choice

Adjust

This section provides you with the information on how to
use the front panel of the spectrum analyzer.

Entering Data

When setting measurement parameters, there are several
ways to enter or modify the value of the active function:

Increments or decrements the current value.
Increments or decrements the current value by step.

Enters a specific value. Then press the desired terminator
(either a unit softkey, or [Enter] hardkey).

Terminate a value that requires a unit of measurement.

Terminates an entry when either no unit of measure is
needed, or you want to use the default unit.

Delete the current input digit before you terminate the input.

Using Softkeys

Softkeys provide access to the analyzer functions. Here are
examples of softkey types:

Activates/deactivates the states.
Displays a secondary menu of softkeys.
Makes a selection from a list of values.

Highlights the softkey and sets the active function.

N9320A Spectrum Analyzer
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Presetting the Spectrum Analyzer

Factory Preset

User Preset

Preset provides a known instrument status for making
measurements. There are two types of preset:

Restores the analyzer to its factory-defined state. Please
refer to “Factory Preset State” on page 108 for details.

Restores the analyzer to a user-defined state.

Press ? > Pwr on/Preset > Preset Type to select the preset
type.

When Preset Type sets to Factory, pressing f4ll > Preset
triggers a factory preset.

When Preset Type sets to User, pressing [0l > Preset displays

both User Preset and Factory Preset softkeys, then select the
preset you need.

Setting up a User Preset

If you constantly use settings that are not the factory
defaults, use the following steps to set up a user-defined
preset:

Set customized parameters as required.

Press @n > Pwr on/Preset > Save User Preset, to save current
instrument settings as the ‘user preset’ state. the user preset
do not affect the default factory preset settings.

Viewing a Signal

N9320A Spectrum Analyzer

Refer to the procedures below to view a simple signal.

Press E > Pow on/Preset > Preset Type > Factory to enable
the factory-defined preset state.

Press > Preset to restore the analyzer to its
factory-defined state.

Connect 10 MHz REF OUT on the rear panel to the front-panel
RF IN.

27
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Setting Reference Level and Center Frequency

Press > 10> dBm to set 10 dBm reference level.
Press (g > 30 > MHz to set 30 MHz center frequency.

Setting Frequency Span
Press [0 > 50 > MHz to set 50 MHz frequency span.

Changing the reference level changes the amplitude value of the top
graticule line. Changing the center frequency changes the horizontal
placement of the signal on the display. Increasing the span increases
the frequency range that appears horizontally across the display.

Reading Frequency and Amplitude
Press E to place a maker (labeled 1) on the 10 MHz peak.

Note that the frequency and amplitude of the marker appear
both in the active function block, and in the upper-right
corner of the screen.

Figure 1 10 MHz Internal Reference Signal

Active function block Marker Annotation
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Use the knob, the arrow keys, or the softkeys in the Peak
Search menu to move the marker. The marker information
will display in the upper-right corner of the screen.

Changing Reference Level

Press and note that reference level (Ref Level) is
now the active function.

Press > Mkr-> Ref Lvl.

Note that changing the reference level changes the amplitude

value of the top graticule line.
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Measuring Multiple Signals
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This section provides the information on how to measure
multiple signals.

Comparing Signals on the Same Screen Using Marker Delta

This analyzer delta marker function lets you compare two
signals when both appear on the screen at one time.

In the following example, harmonics of the 10 MHz reference
signal available at the rear of the analyzer is used to
measure frequency and amplitude differences between two
signals on the same screen. Delta marker is used to
demonstrate this comparison.

Preset the analyzer:
Press > Preset (With Preset Type of Factory)
Connect the rear panel REF OUT to the front panel RF IN.

Set the analyzer center frequency, span and reference level
to view the 10 MHz signal and its harmonics up to 50 MHz:

Press [T > 30 > MHz

Press [EZ0M > 50 > MHz
Press > 10 > dBm

Place a marker at the highest peak on the display (10 MHz):
Press [

Search

The marker should be on the 10 MHz reference signal. Use
the Next Pk Right and Next Pk Left softkeys to move the marker
from peak to peak.

Anchor the first marker and activate a second marker:
Press @ > Delta > Delta (On)

The label on the first marker now reads 1R, indicating that it
is marking the reference point.

Move the second marker to another signal peak using the
front- panel knob or by using Peak Search.

N9320A Spectrum Analyzer
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Press > Next Peak or
Press > Next Pk Right or Next Pk Left.

The amplitude and frequency differences between the
markers are displayed in the active function block.

Figure 2 Delta pair marker with signals on the same screen
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To increase the resolution of the marker readings, turn on the
frequency count function. For more information, please refer to
“Improving Frequency Resolution and Accuracy” on page 43.
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Comparing Signals not on the Same Screen
Using Marker Delta

The analyzer helps you to compare the frequency and
amplitude difference between two signals which are not on
the same screen. (This technique is useful for harmonic
distortion tests.)

In this example, the analyzer’s 10 MHz signal is used to
measure frequency and amplitude differences between one
signal on screen and one signal off screen. Delta marker is
used to demonstrate this comparison.

Preset the analyzer:
Press 'S’J'&_Tg;,', > Preset (With Preset Type set to Factory)
Connect the rear panel REF OUT to the front panel RF IN.

Set the center frequency, span and reference level to view
only the 50 MHz signal:

Press > Center Freq > 50 > MHz
Press [EZ0M > Span > 25 > MHz
Press > Ref Level > 10 > dBm

Place a marker on the 10 MHz peak and then set the center
frequency step size equal to the marker frequency (10 MHz):
Press g-fij;;

Press > Mkr -> CF Step

Activate the marker delta function:

Press [[Hf] > Delta > Delta (On)

Increase the center frequency by 10 MHz:

Press > Center Freq,

The first marker moves to the left edge of the screen, at the
amplitude of the first signal peak.
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Figure 3 shows the reference annotation for the delta
marker (1R) at the left side of the display, indicating that the
10 MHz reference signal is at a lower frequency than the
frequency range currently displayed.

Figure 3 Delta Marker with Reference Signal Off-Screen
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The delta marker appears on the peak of the 100 MHz
component. The delta marker annotation displays the
amplitude and frequency difference between the 10 and
100 MHz signal peaks.

Press @ > Off to turn the markers off.
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Resolving Signals of Equal Amplitude

Signal Generator

In this example a decrease in resolution bandwidth is used
in combination with a decrease in video bandwidth to
resolve two signals of equal amplitude with a frequency
separation of 100 kHz.

Figure 4 Setup for obtaining two signals

Signal Generator Spectrum Analyzer

RF OUT

Directional Coupler

Notice that the final RBW selection to resolve the signals is
the same width as the signal separation while the VBW is
slightly narrower than the RBW.

Connect two sources to the analyzer input as shown above.

Set one source to 300 MHz. Set the frequency of the other
source to 300.1 MHz. Set both source amplitudes to —20 dBm.

Setup the analyzer to view the signals:

Press > Preset (With Preset Type of Factory)
Press g > 300 > MHz

Press B > 300 > kHz

Avg

Press [0 > 2 > MHz

A single signal peak is visible. See Figure 5 for example.
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If the signal peak is not present on the display, span out to
20 MHz, turn signal tracking on, span back to 2 MHz and
turn signal tracking off:

Press [EZ0M > Span > 20 > MHz

Press

Press (fHnay) > Signal Track (On)

Press [[EXM > 2 > MHz

Press (ae) > Signal Track (Off)

Figure 5 Unresolved Signals of Equal Amplitude
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Change the resolution bandwidth (RBW) to 100 kHz so that
the RBW setting is less than or equal to the frequency
separation of the two signals:

Press gW’ > 100 > kHz

Notice that the peak of the signal has become flattened
indicating that two signals are present.

Decrease the video bandwidth to 3 kHz:
Press "W’ > Video BW > 3 > kHz

Two signals are now visible as shown in Figure 6. Use the
front- panel knob or arrow keys to further reduce the
resolution bandwidth and better resolve the signals.
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Decreasing the resolution bandwidth improves the resolution
of the individual signals and increase the sweep time.

Figure 6 Resolving Signals of Equal Amplitude
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For fastest measurement times, use the widest possible
resolution bandwidth. Under factory preset conditions, the
resolution bandwidth is coupled to the span.
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Resolving Small Signals Hidden by Large Signals

N9320A Spectrum Analyzer

This example uses narrow resolution bandwidths to resolve
two input signals with a frequency separation of 50 kHz and
an amplitude difference of 60 dB.

Connect two sources to the RFIN as shown in Figure 4.

Set one source to 300 MHz at —10 dBm. Set the other source
to 300.05 MHz at -70 dBm.

Set the analyzer as follows:

Press iv_ 7 > Preset. (With Preset Type of Factory)
Press GEeg) > 300 > MHz

Press [l > 30 > kHz

Press [EXM > 500 > kHz

Set the 300 MHz signal to the reference level:

Peak
Press

Press > Mkr -> Ref Lel

The 30 kHz filter shape factor of 15:1 has a bandwidth of 450 kHz at the 60
dB point. The half-bandwidth (225 kHz) is NOT narrower than the
frequency separation of 50 kHz, so the input signals can not be resolved.

Figure 7 Unresolved small signal from large signal
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Reduce the resolution bandwidth filter to view the smaller
hidden signal. Place a delta marker on the smaller signal:

Press [#/88 > 1> kHz

\[

Press FE!
Press @ > Delta > Delta (On)

Press 50 > kHz

Figure 8 Resolved small signal from large signal
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The 1 kHz filter shape factor of 15:1 has a bandwidth of 15 kHz at the
60 dB point. The half-bandwidth (7.5 kHz) is narrower than the
frequency separation of 50 kHz, so the input signals can be resolved.
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Measuring a Low-Level Signal

This section provides information on measuring low-level
signals and distinguishing them from spectrum noise.

Reducing Input Attenuation

The ability to measure a low-level signal is limited by
internally generated noise in the spectrum analyzer. The
input attenuator affects the level of a signal passing through
the analyzer. If a signal is close to the noise floor, reducing
input attenuation will bring the signal out of the noise.

Ensure that the total power of all input signals at the analyzer RF input
does not exceed +30 dBm (1 Watt).

1 Preset the analyzer
Press > Preset (With Preset Type of Factory)

2  Set the source frequency to 300 MHz, amplitude to -70 dBm.
Connect the source RF OUT to the analyzer RF IN.

Figure 9 Setup for obtaining one signal

Signal Generator Spectrum Analyzer
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3 Set the center frequency, span and reference level:
Press (e > Center Freq > 300 > MHz
Press G > Span > 2 > MHz
Press > Ref Level > 40 > —dBm.

4 Move the desired peak to the center of the display:
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Peak
Press Se:rch

Press > Mkr -> CF

Reduce the span to 500 kHz, if necessary re-center the peak:

Press B > 500 > kHz

Set the attenuation to 20 dB:
Press > Attenuation > 20 > dB

Figure 10 A signal closer to the noise level
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Note that increasing the attenuation moves the noise floor
closer to the signal level.

To view the signal more clearly, set the attenuation to 0 dB:
Press > Attenuation > 0 > dB

Figure 11  Measuring a low-level signal using 0 dB Attenuation
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Decreasing the Resolution Bandwidth

N9320A Spectrum Analyzer

Resolution bandwidth settings affect the level of internal
noise without affecting the level of continuous wave (CW)
signals. Decreasing the RBW by a decade reduces the noise
floor by 10 dB.

Refer to the first procedure “Reducing Input Attenuation” on
page 39 and follow steps 1, 2 and 3.

Decrease the resolution bandwidth:

Press and

The low-level signal appears more clearly because the noise
level is reduced (see Figure 12).

Figure 12 Decreasing Resolution Bandwidth
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A “#” mark appears next to the Res BW annotation in the
lower left corner of the screen, indicating that the resolution
bandwidth is uncoupled.

The analyzer allows you to change the RBW in a 1-3-10 sequence by
the data control keys. The RBWs below 1 kHz are digital and have a
selectivity ratio of 5:1 while RBWs at 1 kHz and higher have a 15:1
selectivity ratio. The maximum RBW is 3 MHz and minimum is 10 Hz.
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Trace Averaging

Averaging is a digital process in which each trace point is
averaged with the previous average value for the same trace
point. Selecting averaging, when the analyzer is auto- coupled,
changes the detection mode to Sample, smoothing the
displayed noise level.

This is a trace processing function and is not the same as using the
average detector (as described on page 41).

Refer to the first procedure “Reducing Input Attenuation” of
this chapter and follow steps 1, 2 and 3.

Turn average on:
Press > Average (On)
Set the number of averages to 20:

Press 20,

Since the averaging routine smooths the trace, low level
signals become more visible (see Figure 13).

Figure 13  Trace Averaging
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Improving Frequency Resolution and Accuracy

N9320A Spectrum Analyzer

This section provides information on how to improve
frequency resolution and accuracy using the frequency
counter function.

Press > Preset (With Preset Type of Factory)
Connect a cable from the front panel CAL OUT to RFIN;

Then, Press > Alignment > Align > CAL OUT ON to enable
the 50 MHz amplitude reference signal.

Auto
Press p

The analyzer detects the peak of the signal and locate it to
the center of the graticule (Refer to “Auto Tune” on page 73).

Turn the frequency counter on:
Press @ > Function > Freq Counter > Freq Counter (On).

Move the marker, with the front-panel knob, half-way down
the skirt of the signal response.

Figure 14  Using Frequency Counter
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The frequency and amplitude of the marker appears in the active function
area (this is not the counted result). The counted result appears in the
upper-right corner of the display to the right-side of Cntr1.
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Notice that the readout in the active frequency function
changes while the counted frequency result (upper-right
corner of display) does not. To get an accurate count, you do
not need to place the marker at the exact peak of the signal
response.

Frequency counter properly functions only on CW signals or discrete
spectral components. The marker must be greater than 40 dB above
the displayed noise level.

Change counter resolution:

Press M > Function > Freq Counter > Resolution

The frequency-counter resolution ranges from 1 Hz to 1 kHz.
Turn off the marker counter:

Press M > Function > Freq Counter > Freq Counter (Off).

When using the frequency counter function, the ratio of the resolution
bandwidth to the span must be greater than 0.02.
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Tracking Drifting Signals

This section provides information on measuring and tracking
signals that drift.

Measuring a Source’s Frequency Drift

N9320A Spectrum Analyzer

The analyzer allows you to measure the stability of a source.
The maximum amplitude level and the frequency drift of an
input signal trace can be displayed and held by using the
maximum hold function. Using the maximum hold function
also allows you to determine how much of the frequency
spectrum a signal occupies. For more information, please
refer to “Max Hold” on page 116.

Use signal tracking to keep a drifting signal in the center of
the display. The drifting is captured by the analyzer using
maximum hold.

Connect the signal generator to the analyzer RF IN.

Output a signal with the frequency of 300 MHz and
amplitude of -20 dBm.

Set the analyzer center frequency, span and reference level.
Press > Preset. (With Preset Type of Factory)

Press [{&Tag) > Center Freq > 300 > MHz

Press [0 > Span > 10 > MHz

Press > Ref Level > 10 > dBm

Place a marker on the peak of the signal and turn signal

tracking on:
Peak
Press [

Press (g > Signal Track (On)

Press [EZUM > 1> MHz

Notice that this holds the signal in the center of the display.
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Turn off the signal track function:
Press (g > Signal Track (Off)

Measure the excursion of the signal with maximum hold:
Press ""’W > Max Hold

As the signal varies, maximum hold maintains the maximum
responses of the input signal. Annotation on the left side of
the screen indicates the trace mode. For example, M1 S2 S3
indicates trace 1 is in maximum-hold mode, trace 2 and
trace 3 are in store-blank mode.

Activate trace 2 and change the mode to continuous sweep:
Press "’W' > Select Trace > Trace 2
Press Clear Write

Trace 1 remains in maximum hold mode to show any drift
in the signal.

Slowly change the frequency of the signal generator. Your
analyzer display should look similar to Figure 15.

Figure 15  Viewing a Drifting Signal With Max Hold and Clear Write
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Making Distortion Measurements

This section provides information on measuring and
identifying signal distortion.

Identifying Analyzer Generated Distortion

N9320A Spectrum Analyzer

High-level input signals may cause analyzer distortion
products that could mask the real distortion measured on
the input signal. Use trace and the RF attenuator to
determine which signals, if any, are internally generated
distortion products.

In this example, we use a signal from a signal generator to
determine whether the harmonic distortion products are
generated by the analyzer.

Connect the signal generator to the analyzer RF IN.
Set the source frequency to 200 MHz, amplitude to 0 dBm.

Set the analyzer center frequency and span:
Press -F ) > Preset

Press [ETan) > 400 > MHz
Press [0 > 500 > MHz

Figure 16  Harmonic Distortion
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The signal produces harmonic distortion products (spaced
200 MHz from the original 200 MHz signal) in the analyzer
input mixer as shown in Figure 16.

Change the center frequency to the value of the first
harmonic:

Press &M > Next Peak

Search

Press > Mkr -> CF
Change the span to 50 MHz and re-center the signal:
Press [EXM > 50 > MH:z

Peak
Press S::rch

Press > Mkr -> CF
Set the attenuation to 0 dB:
Press > Attenuation > 0 > dB

To determine whether the analyzer generates harmonic
distortion products, first display the trace data in trace 2 as
follows:

Press P > Select Trace > Trace 2

Trace

Press Clear Write

Allow trace 2 to update (minimum two sweeps), then store
the data from trace 2 and place a delta marker on the
harmonic of trace 2:

Press (LM > View

Peak
Press Search

Press M > Delta > Delta (On)

The analyzer display shows the stored data in trace 2 and
the measured data in trace 1. The MarkerA indicator reads
the difference in amplitude between the reference and active
markers.

Increase the RF attenuation to 10 dB:

Press > Attenuation > 10 > dB

N9320A Spectrum Analyzer
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Notice the MarkerA amplitude readout. This is the difference
of the distortion product amplitude between 0 dB and 10 dB
input attenuation settings. If the MarkerA absolute amplitude
is approximately >1 dB for an input attenuator change, the
analyzer is generating, at least in part, the distortion.
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The MarkerA amplitude readout comes from two sources:

1) Increased input attenuation causes poorer signal-to- noise
ratio. This causes the MarkerA to be positive.

2) The reduced contribution of the analyzer circuits to the
harmonic measurement causes the MarkerA to be negative.

Large MarkerA readout indicates significant measurement
errors. Set the input attenuator to minimize the absolute
value of MarkerA.
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Third-Order Intermodulation Distortion

Signal Generator

Two-tone, third-order intermodulation distortion is a
common test in communication systems. When two signals
are present in a non-linear system, they may interact and
create third-order intermodulation distortion (TOI) products
that are located close to the original signals. System
components such as amplifiers and mixers generate these
distortion products.

For an example of the quick setup of TOI measurement,
refer to “Intermod (TOI)” on page 126.

This example tests a device for third-order intermodulation
using markers. Two sources are used, one set to 300 MHz
and the other to 301 MHz.

Connect the equipment as shown in figure below. This
combination of signal generators, low pass filters, and
directional coupler (used as a combiner) results in a
two-tone source with very low intermodulation distortion.
Although the distortion from this setup may be better than
the specified performance of the analyzer, it is useful for
determining the TOI performance of the source/analyzer
combination. After the performance of the source/analyzer
combination has been verified, the device-under-test (DUT)
(for example, an amplifier) would be inserted between the
directional coupler output and the analyzer input.

Signal Generator Spectrum Analyzer
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The coupler should have a high degree of isolation between the two
input ports so the sources do not intermodulate.

2 Set one source (signal generator) to 300 MHz and the other
source to 301 MHz, for a frequency separation of 1 MHz. Set
the sources equal in amplitude as measured by the analyzer
(in this example, they are set to -5 dBm).

3 Set the analyzer center frequency and span:
Press > Preset (With Preset Type of Factory)
Press (s > Center Freq > 300.5 > MHz
Press (5200 > Span > 5 > MHz

4 Reduce the RBW until the distortion products are visible:

Press and
b Move the signal to the reference level:

Peak
Press §eh

Press > Mkr -> Ref Lvl

6 Reduce the RBW until the distortion products are visible:

Press and

7 Activate the second marker and place it on the peak of the
distortion product (beside the test signal) using the Next Pea:

Press M > Delta > Delta (On)

Press B&iS8 > Next Peak

Search

8 Measure the other distortion product:

Press M > Normal

Press &M > Next Peak

Search
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Measure the difference between this test signal and the
second distortion product (see Figure 17):

Press @ > Delta > Delta (On)
Press -I= > Next Peak

Figure 17 Measuring the Distortion Product
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Measuring Phase Noise

N9320A Spectrum Analyzer

Phase noise is a frequency domain measure of stability. We
specify phase noise as single-sideband power in relation to
the fundamental RF output frequency, and measured at
various offset frequencies from the carrier, normalized to a
one hertz measuring bandwidth.

In this example the 50 MHz amplitude reference signal is
used as the fundamental signal.

Press > Preset. (With Preset Type of Factory)

Connect a cable from the front panel CAL OUT to RFIN.
Press > Alignment> CAL OUT On

Press to auto-tune the signal to the center of display.
Press to place a marker on the peak of the signal.
Turn on the phase noise function to view the results:
Press @ > Function > Phase Noise > Phase Noise (On)

Change the offset:

Press @ > Function > Phase Noise > Offset Manual

Then change the offset by pressing the corresponding
softkeys under the Phase Noise menu.

Atten 10 dB

Marker A
20.000 kHz
Noise -97.91 dBc/Hz
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Stimulus Response Transmission

54

The procedure below describes how to use a built-in
tracking generator to measure the rejection of a low pass
filter, a type of transmission measurement.

To measure the rejection of a low pass filter, connect the
equipment as shown in Figure 18. A 370 MHz lowpass filter
as the DUT.

Figure 18 Transmission Measurement Test Setup

{BlE

©/ 5000

DUT

Press > Preset. (With Preset Type of Factory)

Set the start and stop frequencies and resolution bandwidth:
Press (MG > Start Freq > 100 > MHz

Press [En) > Stop Freq > 1> GHz

Press > Res Bw > 3 > MHz

Turn on the tracking generator and if necessary, set the
output power to -10 dBm:

Press @ > Tracking Generator > Amplitude TG(On) > -10 > dBm

Excessive signal input may damage the DUT. Do not exceed the
maximum power that the device under test can tolerate.
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To reduce ripples caused by source return loss, use 6 dB or greater
output attenuation. Tracking generator output attenuation is normally
a function of the source power selected. However, the output
attenuation may be controlled in the Tracking Generator menu.

b Increase measurement sensitivity and smooth the noise:

Press > Res Bw > 30 > KHz

Press w88 > Video Bw > 300 > KHz

A decrease in displayed amplitude is caused by tracking
error.

6 Use peak tracking to correct the frequency offset:
Press [l > Tracking Generator > More > Tracking Peak

Tracking error occurs when the output frequency of the
tracking generator is not exactly matched to the input
frequency of the analyzer. The amplitude should return to
the value that was displayed prior to the decrease in
resolution bandwidth.

7 Connect the cable from the tracking generator output to the
analyzer input. Store the frequency response in trace 3 and
normalize:

Press > Tracking Generator > More > Normalize > Store Ref (1
— 3) > Normalize (On)

8 Reconnect the DUT to the analyzer and change the
normalized reference position:

Press @ > Tracking Generator > More > Normalize > Norm Ref
Posn > 8

N9320A Spectrum Analyzer b5
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Measure the rejection of the lowpass filter:
Press @ > Normal > 370 > MHz, Delta > 160> MHz

The marker readout displays the rejection of the filter at 130
MHz above the cutoff frequency of the lowpass filter. See
Figure 19 as below.

Figure 19

Measure the Rejection Range

Mkrl & It
Atten 20 db
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Measuring Stop Band Attenuation of a Lowpass Filter

When measuring filter characteristics, it is useful to look at
the stimulus response over a wide frequency range. Setting
the analyzer x-axis (frequency) to display logarithmically
provides this function. The following example uses the
tracking generator to measure the stop band attenuation of a
370 MHz low pass filter.

1 To measure the response of a low pass filter, connect the
equipment as shown in Figure 20. This example uses a
370 MHz low pass filter.

Figure 20 Transmission Measurement Test Setup

o o e e )

Coon
[B][&]E]

DUT J

2  Press > Preset. (With Preset Type of Factory)

3 Set the start and stop frequencies and resolution bandwidth:
Press (g > Start Freq > 100 > MHz

Press > Stop Freq > 1 > GHz
Press > Scale Type > Log
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10

Set the resolution bandwidth to 10 kHz:

Press [#88 > Res Bw > 10 > KHz

Excessive signal input may damage the DUT. Do not exceed the
maximum power that the device under test can tolerate.

Turn on the tracking generator and if necessary, set the
output power to -10 dBm:

Press m > Tracking Generator > Amplitude TG(On) > -10 > dBm

Connect the cable (but not the DUT) from the tracking
generator output to the analyzer input. Store the frequency
response into trace 3 and normalize:

Press m > Tracking Generator > More > Normalize > Store Ref (1
— 3) > Normalize (On)

Reconnect the DUT to the analyzer. Note that the units of
the reference level have changed to dB, indicating that this
is now a relative measurement.

To change the normalized reference position:

Press [l > Tracking Generator > More > Normalize > Norm Ref
Posn > 8

Place the reference marker at the specified cutoff frequency:
Press [[Hf] > Delta Pair (Ref) > 370 > MHz

Place the second marker at 37 MHz:

Press M > Delta Pair (Delta) > 37 > MHz

N9320A Spectrum Analyzer
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In this example, the attenuation over this frequency range is
-17.98 dB/octave (one octave above the cutoff frequency).

Use the front- panel knob to place the marker at the highest
peak in the stop band to determine the minimum stop band
attenuation. In this example, the peak occurs with Delta of
563 MHz. The attenuation is -60.93 dB. See Figure 21.

Figure 21  Minimum Stop Band Attenuation

Mkrl & 5

Atten 20 dB

VEK 10,00 kHz
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Making a Reflection Calibration Measurement

The following procedure makes a reflection measurement
using a coupler or directional bridge to measure the return
loss of a filter. This example uses a 370 MHz lowpass filter
as the DUT.

The calibration standard for reflection measurements is
usually a short circuit connected at the reference plane (the
point at which the device under test (DUT) is connected.)
See Figure 22, a short circuit has a reflection coefficient of
1 (0 dB return loss). It reflects all incident power and
provides a convenient 0 dB reference.

1 Connect the DUT to the directional bridge or coupler as
shown in Figure 22. Terminate the unconnected port of the
DUT.

Figure 22  Reflection Measurement Short Calibration Test Setup

Reference Plane Short
Circuit

or

H

DUT

>:

Coupled Port

Directional
Bridge/Coupler

WA
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If possible, use a coupler or bridge with the correct test port connector
for both calibrating and measuring. Any adapter between the test port
and DUT degrades coupler/bridge directivity and system source
match.

Ideally, you should use the same adapter for the calibration and the
measurement. Be sure to terminate the second port of a two port
device.

2 Connect the tracking generator output of the analyzer to the
directional bridge or coupler.

3 Connect the analyzer input to the coupled port of the
directional bridge or coupler.

4 Press Nl > Preset. (With Preset Type of Factory)

5 Turn on the tracking generator and if necessary, set the
output power to -10 dBm:

Press m > Tracking Generator > Amplitude TG (On) > -10 > dBm

Excessive signal input may damage the DUT. Do not exceed the
maximum power that the device under test can tolerate.

6 Set the start and stop frequencies and resolution bandwidth:

Press [{ETag) > Start Freq > 100 > MHz

Press Erg) > Stop Freq > 1> GHz
Press [l > Res Bw >3 > MHz

7 Replace the DUT with a short circuit.
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Normalize the trace:

Press > Tracking Generator > More > Normalize > Store Ref (1
— 3) > Normalize (On)

This activates the trace 1 minus trace 3 function and display
the results in trace 1 (Figure 23). The normalized trace or
flat line represents 0 dB return loss. Normalization occurs
each sweep. Replace the short circuit with the DUT.

Since the reference trace is stored in trace 3, changing trace 3 to Clear
Wirite invalidates the normalization.

Figure 23  Short Circuit Normalized

Atten 20 db

N9320A Spectrum Analyzer



Functions and Measurements 3

Measuring Return Loss Using the Reflection Calibration Routine

This procedure uses the reflection calibration routine in the
proceeding procedure “Making a Reflection Calibration
Measurement” on page 60 to calculate the return loss of the
370 MHz lowpass filter.

1 After calibrating the system with the above procedure,
reconnect the filter in place of the short circuit without
changing any analyzer settings.

2 Use the marker to read return loss. Position the marker with
the front-panel knob to read the return loss at that
frequency.

Rotate the knob to find the highest peak and the readout is
the maximum return loss. See Figure 24.

Figure 24  Measuring the Return Loss of the Filter

Atten 20 dB

#VEK 3.000 kHz
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Viewing Catalogs and Saving Files

The analyzer stores and retrieves data similar as a PC. The
analyzer allows you to view and save files in the internal
storage or the USB storage device. This section provides
information on how to locate catalogs and save a file.

Locating and Viewing Files in the Catalog

State
Trace
Screen

Limits

64

The analyzer has four types of files:

stores analyzer settings. The extension is .STA.

stores trace information. The extension is .TRA.

stores screen captures of the display. The extension is .JPG.
which stores data sets to determine whether a trace has

exceeded preset specifications. The extension is .LIM.

Trace files are not bitmap files. It cannot be imported into other
applications or converted. If you require the use of other applications,
be sure to save as .JPG formats using Screen for your file type.

Press > Catalog to bring up a screen display below.

% Agilent 00:18:04 01-11-2008

Catalog
Nams:
Tupe: State
Path: usb~

Modified

state224 STH 30/10/08 15:12:08
state22s STh 52172 30710406 15:12:10
l=ed: 112263 KB Free: 417071 kB
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1 The entry fields show the parameters for the files viewed:
Name states the filename.
Type displays the type of files viewed.
Path displays the location of the files (Local or USB).
2 There are four column headings in this area of the display:
Name displays the filename.
Type displays the filename extension (TRA, STA, TRC or JPG).
Size displays the size of the file in bytes.
Modified displays the date and time the change occurred.
3 The softkey menu has four options:
Type selects the type of file you wish to view.
Sort sorts and views the files according to a file attribute.
Local accesses the internal storage to view files.
USB accesses the external USB storage device to view files.

4 The drive space line shows the number of bytes used on the
drive and the number of bytes still free on the drive.

Saving a File

The analyzer allows you to save files (states, traces, limits or
screens) to a USB storage device (USB/), or the internal
storage (Local/). This example will show you how to save a
trace to the internal storage (Local/).

1 Select a destination for the saved file. Assume you select the
internal storage (Local/):

Press > Catalog > Local
2 Press Return > Save to access the Save menu.

3 Select the type of file. Assume you need to save a trace. The
extension for this file type is TRA:

Press Type > Trace
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Select the trace you need (1, 2, 3, 4 or all traces). Assume
you need to save trace 3:

Press Source > Trace 3

Enter a filename by pressing Name. Assume you name the
file “TEST1”. (The numeric keypad is also available for the
filename.) Pressing will terminate the entering and
return to the Save menu.

The filename is composed of alpha (A-Z) or numeric (0-9) in
any combination. The analyzer will not allow you to
overwrite an existing file. If you enter a filename that
already exists, the status bar will display the message: “File
already exists”. If you do not edit a filename, the analyzer will
automatically generate a name based on the type of file you
are saving (State: STATE, Trace: TRACE, Limits: LIMIT, Screen:
SCREN). It also generates a three digit integer (starting at
000 and extending through 999, remembering the previously
saved value through a power cycle) which it adds to the
name, for example: TRACE056.TRC.

Press Save Now to save the file

“Saving Now” is displayed during this operation. In this
example, the status bar displays “Local/TEST1.TRC file saved”.

When saving file to the USB storage device, never remove the USB
device during the save operation to prevent unexpected data loss.

Loading a File

1

Select the directory where your file is located. In this
example, select the internal storage (Local/):

Press > Catalog > Local
Press Return > Load to access the Load menu

Select the type of file. Assume you need to load a trace file:
Press Type > Trace

N9320A Spectrum Analyzer
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Using the knob or arrow keys to highlight the file you need.
And then select the trace into which you wish to load the
file. Assume you need to load file TEST1.TRC into Trace 2:

Press Destination > Trace 2.

Press Load Now to load the specified file. The status bar
displays: “Local/TEST1.TRC file loaded”. Screen files cannot be
loaded, which are just used in PC applications.

Copying a File

If you need to copy a file from the internal storage to the
USB storage device, please refer to the following procedures:

Press [l > Catalog > Local to select the path

Print.__

Connect a USB storage device to the USB connector (DEV).
Select the type of file. Assume you need to copy a trace file:
Press Return > Copy > Type > Trace

Using the knob or arrow keys to highlight the file name you
need. In this example, highlight the file TEST1.TRC.

Press Copy Now to execute the operation. A “Copying file”
indicator displays. Then “/USB/TEST1.TRC file copied” appears
on the status bar. You have now copied the file TEST1.TRC
from the internal storage to the USB storage device.

Deleting a File

N9320A Spectrum Analyzer

Press > Catalog > Local to select the path
Press Return > Delete to access the Delete menu

Select the type of file. Assume you need to delete a trace file
press Type > Trace

Using the knob or arrow keys to highlight the file name you
want to load. In this example, selecting the file TEST1.TRC.

Press Delete Now. “Deleting file” indicates the operation is in
process. Then, “Local/TEST1.TRC file deleted” shown on the
status bar indicates the file has been deleted.
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Agilent N9320A Spectrum Analyzer
User's Guide

4
Key Reference

This chapter describes each front panel hardkey and
associated softkeys. The front panel keys in this chapter are
listed alphabetically. The lower level softkeys are arranged as
they appear in your analyzer menus.

Agilent Technologies 69
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Amplitude

70

Ref Level

Attenuation
Auto Man

Scale/Div

Scale Type
Log Lin

Press activates the reference level function and
accesses the amplitude softkeys.

Sets the reference level. This function is activated when

is pressed. The reference level is the amplitude power
or voltage represented by the top line of the graticule on the
display. Setting the reference level changes the absolute
amplitude level (in the selected amplitude units) of the top
graticule line.

Key access: [T

Toggles the input attenuation between Auto and Man and set
the attenuation level in 5 dB increments when Man is
selected. The analyzer input attenuator, which is normally
coupled to the reference level control, reduces the power
level of the analyzer input signal at the input mixer.
Selecting Auto re-couples the attenuator. Change the
attenuation by using the arrow keys, the knob, or the
numeric keypad.

Key access: [T

Sets the logarithmic units per vertical graticule division on
the display. The Scale/Div function is available only when the
Scale Type key is set to Log.

Key access: [LIIRan

Scales the vertical graticule divisions in logarithmic units
when Log is selected. The valid logarithmic units are 1, 2, 5
and 10 dB per division. When Lin is underlined, the vertical
divisions are linearly scaled with default amplitude units of
volts. The top of the graticule represents the reference-level
value; the bottom of the graticule represents zero volts.
(Each division is one-tenth of the reference level.)

Key access: [T

N9320A Spectrum Analyzer



Int Preamp
On Off

Y Axis

Ref Lvl Offset

Ext Amp Gain

N9320A Spectrum Analyzer

Key Reference 4

(Option PA3) Toggles the internal pre-amplifier function
between on and off. Pressing Int Preamp (On) results in a
correction being applied to compensate for the gain of the
preamp. Amplitude readings then represent the signal value
at the input connector. When the preamp is on, a “PA”
indication appears on the left side of the display. The
preamp operates over a range of 100 kHz to 3 GHz.

Key access: [LHTs

Accesses the softkeys that change the amplitude units
(logarithmic or linear). Change the amplitude units by
pressing dBm, dBmV, dBuV, dBuA, Watts, Volts, and Amps.

Key access: > More

Adds an offset value to the displayed reference level.
Reference-level offsets are only entered by using the numeric
keypad. Entering an offset does not affect the trace or the
attenuation value. Reference-level offsets are used when gain
or loss occurs between a device under test and the analyzer
input. Thus, the signal level measured by the analyzer may
be referred to as the level at the input of an external
amplitude- conversion device. When an amplitude offset is
entered, its value appears on the left side of the display
under Offst (as opposed to frequency offsets which appear
at the bottom of the display). To eliminate an offset, press
Ref Lvl Offst > 0 > dB.

Key access: > More

Adds a positive or negative preamplifier gain value, which is
subtracted from the displayed signal. (Use negative values
for gain and positive values for loss.) The function is similar
to the Ref Lvl Offset function, however with the Ext Amp Gain
function, the attenuation may be changed depending on the
preamplifier gain entered. A preamplifier gain offset is used
for measurements that require an external preamplifier or
long cables. The offset is subtracted from the amplitude
readout so that the displayed signal level represents the

n
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signal level at the input of the preamplifier. The preamplifier
gain offset is displayed at the top of the screen and is
removed by entering zero. The preamplifier gain offset can
only be entered using the numeric keypad. The preamplifier
gain value is not affected by an instrument preset or a
power cycle.

Key access: [Mrey > More
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N9320A Spectrum Analyzer

Key Reference

Activates the autotune function to view the signal, This
hardkey functions as following description:

Run Peak Search in full span

Run Mkr -> CF

Select the appropriate reference level according to the
amplitude of searching signal.

Set span to 1 MHz and all auto couple to view the signal.

The Auto Tune functions in the frequency range of 5 MHz to 3 GHz.

The minimum detectable amplitude is —65 dBm.

For more information about Peak Search, Mkr— CF and
Mkr— Ref Lel softkeys, please refer to “Peak Search” on
page 103, and “Marker->" on page 97.
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Back <-

The backspace key is located on the front panel and is used
to change or correct an active function entry, or to change a
text entry before you save data to a file.

74 N9320A Spectrum Analyzer



BW/Avg

Res BW
Auto Man

Video BW
Auto Man

VBW/RBW
Auto Man

N9320A Spectrum Analyzer

Key Reference 4

Activates the resolution bandwidth function and accesses the
softkeys that control the bandwidth functions and averaging.

Changes the 3 dB resolution bandwidth of the analyzer from
10 Hz to 3 MHz using the knob or arrow keys. When under
1 kHz, the available bandwidth is 10, 30, 100 Hz or 300 Hz.
If you enter an invalid bandwidth using the numeric keypad,
the analyzer uses the closest available bandwidth. As the
resolution bandwidth is decreased, the sweep time is
modified to maintain amplitude calibration. Resolution
bandwidth is also related to span. As span decreases, the
resolution bandwidth decreases. As the resolution bandwidth
changes, the video bandwidth, if VBW/RBW is set to AUTO,
changes to maintain the VBW/RBW ratio.

A “#” mark appears next to “Res BW” on the display when it
is not coupled. To recouple the resolution bandwidth, press
Res BW (Auto).

- I
Key access:

Changes the analyzer post-detection filter from 1 Hz to 3
MHz using the knob or arrow keys. If you enter an invalid
bandwidth, the analyzer use the closest available bandwidth.
As the video bandwidth decreases, the sweep time increases
to maintain amplitude calibration.

A “#” mark appears next to “VBW” on the bottom of the
analyzer display when it is not coupled. To couple the video
bandwidth, press Video BW (Auto).

N BW|
Key access:

Sets the ratio between the video and resolution bandwidths.
If a signal level close to noise level is visually masked by the
noise, you need to set the ratio to less than 1 to lower the
noise. When Preset Type is set to Factory and Preset is pressed,
the ratio is set to 1. Change the ratio by using the arrow
keys, knob, or numeric keypad. When VBW/RBW (Auto) is
selected, the ratio is determined automatically by the rules
in Figure 1.
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Average
On Off

76

Figure 1 VBW/RBW Ratio Auto Rules

Is Trace
Average On?

Is Detector peak
or Negative peak?

Is Detector
Sample?

Is Avg Type
Power?

Is Avg Type
Power?

Is Trace
Average On?

B BW|
Key access:

Initiates a digital averaging routine that averages the trace
points in a number of successive sweeps resulting in trace
“smoothing”. The number of sweeps (average number) is
changeable when setting Average (0ff). Increasing the average
number will further smooth the trace. pressing > Avg
Type to select the type of averaging.

To restart averaging:
* Enter a new average number
¢ Change any related parameter (e.g., Center Frequency)

When in sweep single, the specified number of averages is
taken, then the sweep stops and an average trace displayed.
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Auto Man

N9320A Spectrum Analyzer

Key Reference 4

When in continuous sweep mode, the specified number of
averages is taken, then the averaging continues with each
new sweep averaged in with a weight of and the
old average reduced by multiplying it by

1

1
AverageNumber

AverageNumber — A—verageNumber .

To turn averaging off, press Average (Off).
Key access:

Toggles the average type between automatic and manual.

Selecting Auto sets the analyzer to automatic averaging by the
rules in Figure 2.

Figure 2  Auto Rules for Average Type

Is Detector

Type=Power

Average?

Selecting Man sets the analyzer to manual averaging.

When trace average is on, the average type is shown on the
left side of the display. Selecting an average type manually
causes the analyzer to use that type without regard to other
analyzer settings and sets Avg Type to Man.

- N
Key access:

Video Avg Video averaging averages the data as appropriate
for the y-axis scale. When Avg Type > Video Avg is
selected, “VAvg” appears on the left side of the
analyzer display if Average is On.

Key access: > Avg Type

Pwr Avyg Power averaging is performed by converting the
trace data from logarithmic to linear power units,
and then averaging the power trace data. When
Avg Type > Pwr Avg is selected, “PAvg” appears on
the left side of the screen if Average is On.

Key access: > Avg Type
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Det/Display

78

Detector
Auto Man

Press this hardkey to control detector and display functions.

Selects a specific detector, or allows to pick the appropriate
detector (through Auto) for a particular measurement.

When discussing detectors, it is important to understand
what is a trace “bucket”. For every trace point displayed,
there is a finite time during which the data for that point is
collected. The analyzer look at all of the data collected
during that time and present a single point of trace data
based on the detector mode. We call the interval during
which the data for that trace point is being collected, the
“bucket”. Thus a trace is more than a series of single points.
It is actually a series of trace “buckets”. The data may be
sampled many times within each bucket.

Figure 3 Detector (auto) Selection Flowchart Rules

Phase
Noise On?

Trace
Average On?

No

Any Trace in Any Trace in
Max Hold? MinHold?

f Yes
Alcly T|:c|:;n Negative Peak
in Hold?

No

N9320A Spectrum Analyzer



Key Reference 4

When the detector sets to Aute, Pressing > Average (On)
changes the detector. The Auto choice depends on marker
functions, trace functions, and the trace averaging function.
If a marker function or measurement is running, the Auto
choice of detector is either Average or Sample. When one of
the detectors (such as Average) is manually selected instead
of Auto, that detector is used without regard to other
analyzer settings.

e Average displays the power average in the bucket.

e Sample displays the instantaneous level of the signal at
the center of the bucket represented by each
display point.

¢ Positive Peak displays the max. of the signal in the bucket.
¢ Negative Peak displays the min. of the signal in the bucket.

The detector in use is indicated on the left side of the
display. A “#” will appear next to it if the detector has been
manually selected.

Key access:

Auto Selects peak detection as the default. If a
measurement arises where a different
detection scheme would be better utilized, the
system will use the alternate scheme.

Key access: [{## > Detector Auto Man

Positive Peak  Obtains the maximum video signal between the
last display point and the present display
point and stores this value in memory. It’s
used primarily when measuring sinusoidal
components. When Positive Peak is selected,
“Peak” appears in the upper-left corner.

Key access: 7 > Detector Auto Man

Negative Peak functions as peak detection, but selects the
minimum video signal value. This detection
should not be used to measure the accurate
amplitude. “NPk” also appears in the upper-left
corner, When Negative Peak is selected.

Key access: [l > Detector Auto Man
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Active Fctn
Position

Average
Video RMS

Sample

Normal

measures the average value of the amplitude
across each trace interval (bucket). When
Average is selected, “Avg” appears on the left
corner.

Key access: [ZWl > Detector Auto Man

Sample detection is used primarily to display
noise or noise-like signals. It should not be
used to measure the accurate amplitude of non
noise-like signals. In sample mode, the
instantaneous signal value of the present
display point is placed in memory. When Sample
detection is selected, “Samp” appears in the
upper-left corner of the display.

Key access: [{## > Detector Auto Man

Selects the maximum and minimum video signal
values alternately. When selecting Normal
detection, “Norm” appears in the upper-left
corner.

Key access: [{<##l > Detector Auto Man

Selects the screen position for the Active Function Display.
Depending on the type of trace data being viewed, you can
move the Active Function Display position for less visual
interference with your screen data.

B Det)
Key access:

Top

Center

Bottom

Displays the active function in the top-left cor-

ner of the display.

Key access: {{Z# > Active Fctn Position

Displays the active function in the center-left
side of the display.

Key access: <l > Active Fctn Position

Displays the active function in the bottom-left
corner of the display

Key access: =¥l > Active Fctn Position
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Display Line  Activates an adjustable horizontal line that is used as a
On Off visual reference line. The line, which can be used for trace
arithmetic, has amplitude values that correspond to its
vertical position when compared to the reference level. The
value of the display line appears in the active function block
and on the left side of the display. Use the arrow keys,
knob, or numeric keypad to adjust the display line. Pressing
any digit, O through 9, on the numeric keypad brings up the
selected terminator menu.

B Det|
Key access:

Limits Accesses softkeys that allow you to create and define the
parameters of limit lines.

N Det|
Key access:

Limit1 selects either of the available limits. The Limit1 and
Limit2 Limit2 keys access softkeys to set parameters for the
selected limit.

Key access: [ > Limits

Type defines the limit you are editing as either

Upper lower an upper or lower limit. An upper limit
fails if trace 1 exceeds the limit. A lower
limit fails if trace 1 falls below the limit.

Key access: > Limits > Limit 1/2

Limit Toggles the limit line between on and off.

On Off You need to edit the limit points before
you turn on the limit function. Either
Limit or Margin, as well as Test, must be
turned on for a limit test.

Key access: {{### > Limits > Limit 1/2
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Test
On Off

Margin
On Off

Edit

Toggles the testing of the limit lines
between on and off. If trace 1 is at or
within the bounds of the set limit or
margin, “Limit_# Pass” or “Margin_# Pass” is
displayed in the upper left corner of the
measurement area limit line. Only
positive/negative margins are allowed for
lower/upper limits. If the trace is out of
the limit or margin boundaries, “Limit_#
Failed” or “Margin_# Failed” is displayed.
Either Limit or Margin must be turned on
for test.

Key access: [f#i¥ > Limits > Limit 1/2

Toggles the margin between on and off.
Use Margin to set a limit line offset for
the selected limit line. Either Limit or
Margin as well as Test, must be turned on
for a limit test to work.

Key access: > Limits > Limit 1/2

Accesses the submenu to edit the limit
point, and also accesses the limits table.
Use arrow keys to move between the rows
in the limits table. New limit segments
will only be applied after close the editor.
Pressing Return, or any key not associated
with the editor, will close the editor.

Key access: [ZZM > Limits > Limit 1/2

Display

Point

Creates or edit a limit point. Up to 20
points can be defined for each limit line.
Enter the point number using the numeric
keypad, then Press [Enter], or use the
knob or arrow keys to move to an existing
point.

Key access: |5}

T > Limits > Limit 1/2 > Edit
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Frequency

Edits the frequency value for a limit point.
After editing, the limit table will place the
frequency or time in correct order. For a
new point, Amplitude defaults to 0 dBm and
Connected defaults to Yes.

Key access: FEBS > Limits > Limit 1/2 > Edit

Display
Amplitude
Sets the amplitude value for the current
point.

Key access: > Limits > Limit 1/2 > Edit

Connected To Previous Pt
Yes No

Determines whether the current point will

be connected to the previous point. Pressing
this key toggles the Connected value of the

current point between Yes and No.

Key access: [{<##l > Limits > Limit 1/2 > Edit

Delete Point

Deletes the current point in the limit line.
Pressing this key will delete the point
immediately.

Key access: > Limits > Limit 1/2 > Edit

Delete Limit Deletes the current limit set. Pressing this
key will delete the limit immediately.

Key access: HZ# > Limits > Limit 1/2

Delete Purges data from the limit-line tables. Pressing this key
All Limits  will delete all the limits immediately.

Key access: [7Z > Limits
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Enter

84

Terminates a front-panel keypad numeric entry and enters
that value into the analyzer. (For most applications, it is
better to use the units softkeys to terminate value entry.)
When in File menu, the [Enter] key is used to terminate
filename entries.

N9320A Spectrum Analyzer



File

Catalog
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Accesses the softkeys that allow you to manage the file
system of the analyzer. Refer to “Viewing Catalogs and
Saving Files” on page 64, for more information.

Displays all files located on the selected catalog, depending
upon the preferences set under the Type and Sort keys
defined below.

. i3
Key access:

Type

Sort

selects all types or one type of file(s) for viewing.
Default: State

Key access: @ > Catalog

All

Screen

State

Trace

Limits

Displays all files on the selected drive.
Key access: @ > Catalog > Type

Displays all screen (.JPG) files on the
selected drive.

Key access: E > Catalog > Type

Displays all state files (.STA) on the
selected drive. State files contain most
instrument settings.

Key access: > Catalog > Type

Displays all trace files (.TRA) on the
selected drive.

Key access: @ > Catalog > Type

Displays all limits files ((.LIM) on the
selected drive.

Key access: @ > Catalog > Type

Sorts your files according to a selected file
attribute, including By Date, By Name, and Order Up
Down. Order (Up) sorts files in ascending order
(such as A, B, C). Order (Down) allows you to sort
files in descending order (such as C, B, A).

Key access: > Catalog
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Save

Local

usB

Accesses the internal storage of the analyzer.
Key access: > Catalog

Accesses the external USB storage device.
Key access: % > Catalog

Accesses menu keys that allow you to save analyzer screen,
states, traces and limits data to a USB storage device or
internal storage.

Key access: m

Save Now

Type

Executes the save function. When completed, the
message “local(USB)/XXX file saved” (where XXX is
the filename) will appear in the status bar.

Key access: % > Save

Selects the type of data for your save.
Key access: % > Save

Screen Displays all previously saved screen
files (.JPG) and captures the current
screen displayed in preparation to
save it in a file ((JPG).

Key access: m > Save > Type

State Displays all saved state (.STA) files
and detects the current state
parameters in preparation to save
into a file (.(STA). State files include
all settings but not traces or limits.

Key access: > Save > Type

Trace Displays all previously saved trace
files ((.TRA) and detects the current
trace in preparation to save it in a
file ((TRA). Save individual traces or a
group of traces.

Key access: > Save > Type
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Load

Source

Name
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Limits Displays all previously saved limits files
(.LIM) and detects the current limits in
preparation to save them in a file (.LIM).
Limits provide data sets to determine
whether a trace has exceeded preset
specifications.

Key access: @ > Save > Type

When Type is Trace, you can save trace 1, 2, 3or 4
along with state. All Traces saves all traces in a
single file, along with the state.

When Type is Limits, Source accesses the Limit1 and
2 softkeys. Limit1 and 2 provide data sets to
determine whether a trace has exceeded preset
specifications.

Key access: [{#{#] > Save

Accesses the softkeys to enter a filename.
Key access: E > Save

Only capital letters (A-Z) and digits (0-9) may appear in file names. The
instrument automatically adds a three character file extension.

Accesses a submenu to load analyzer states, traces and
limits into the analyzer from a USB storage device or
internal storage (Local).

Key access: E

Load Now

Type

Executes the load function. When load completed,
the message “local(usb)/XXX file loaded” (where XXX
is the filename) appears in the status bar.

Key access: @ > Load

Selects the type of file for your load.

Key access: {8 > Load

87



4  Key Reference

State Displays all state files for your load
(.STA). Loading a state restores most
settings to the saved values.

Key access: > Load > Type

Trace Displays all trace files (.TRA) for your
load. Load traces individually or as a
group. Loading a trace also loads the
current state, and sets the trace to
view mode.

Key access: > Load > Type

Limits Displays all limits files for your load to
determine whether a trace has
exceeded preset specifications (.LIM).
Limits are loaded individually only.

Key access: > Load > Type

Sort Accesses a submenu to view your saved files
according to a selected file attribute. The
selections include, By Date, By Name, and Order Up
Down. Order (Up) sorts files in ascending order
(such as A,B,C). Order (Down) sorts files in
descending order (such as C,B,A).

Key access: (428 > Load

Destination With Type set to Trace, Destination directs the data
to Trace 1, 2, 3 or 4. If the data is for all four
traces (for instance, Source was All Traces when
they were saved), the data returns to the original
trace registers.

When Type is set to Limits, Destination allows you
to direct your data to Limit1 or Limit 2.

Key access: > Load

Delete Enter the submenu for deletion.

B Fil
Key access:
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Delete Now

Type

Sort

Key Reference 4

Executes the delete function. After a successful
delete, the message “local(USB)/XXX file deleted”
(where XXX is the filename) appears in the
status bar on the display.

Key access: % > Delete

Selects the type of file to delete.
Key access: % > Delete

All Displays all files for deletion.
Key access: % > Delete > Type

Screen Displays screen files for deletion.
Key access: % > Delete > Type

State Displays state files for deletion.
Key access: m > Delete > Type

Trace Displays trace files for deletion.
Key access: % > Delete > Type

Limits Displays limits files for deletion.
Key access: % > Delete > Type

Sorts the files according to a file attribute for
deletion: By Date, By Name and Order Up Down.
Order (Up) displays files in ascending order. Order
(Down) displays files in descending order.

Key access: % > Delete

Enter the submenu for copy files from local to usb storage

device.

Key access: %

Copy Now

Executes the copy function. If the copy is
successful, “local/XXX file copied to USB” (where
XXX is the filename) will appear in the status
bar.

Key access: % > Copy
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Type Select the type of file to copy.
Key access: % > Copy
All Displays all files for your copy.

Key access: % > Copy > Type

Screen Displays all screen files for your copy.
Key access: % > Copy > Type

State Displays all state files for your copy.
Key access: % > Copy > Type

Trace Displays all trace files for your copy.
Key access: % > Copy > Type

Limits Displays all limits files for your copy.
Key access: % > Copy > Type

Sort Sorts the files according to a file attribute for you
copy, including By Date, By Name and Order Up
Down. Order (Up) displays files in ascending order.
Order (Down) displays files in descending order.

Key access: > Copy
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Center Freq

Start Freq

Stop Freq

CF Step
Auto Man
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Key Reference 4

Press () activates the center frequency function, and
accesses the menu of frequency functions. The center
frequency, or start and stop frequency values appear below
the graticule on the display.

When changing both the center frequency and span, change the
frequency first since the frequency value can limit the span.

Activates the center frequency function and sets the
horizontal center of the display to a specific frequency.

Key access: (B0

Sets the frequency at the left side of the graticule. The left
and right sides of the graticule correspond to the start and
stop frequencies.

Key access: (B

Sets the frequency at the right side of the graticule. The left
and right sides of the graticule correspond to the start and
stop frequencies.

Key access: (B0

Changes the step size for the center frequency function. On
selecting a step size and activating the center frequency
function, the arrow keys change center the frequency by the
step-size value. The step size function is useful for finding
harmonics and sidebands beyond the current frequency span
of the analyzer. Selecting auto-couple sets the center
frequency step size to one division (10 percent of the span).

Key access: (B0
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Signal Track Moves the signal that is nearest to the active marker to the
On Off center of the display and keeps the signal there. “ST”
appears in the lower-left corner of the display.

Pressing Signal Track (Off); > Preset (Preset Type set to
Factory); or M > All Off turns off the signal track function.

Setting signal track on and reducing the span initiates an
automatic zoom and reduces the span in steps, so that the
signal remains at the center of the display. If the span is
zero, signal track cannot be activated.

Key access: (B

If no marker is active, pressing Signal Track (On) activates a marker,
perform a peak search, and center the marker on the display.
Switching to zero span sets Signal Track (Off).
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Select Marker

Normal
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Delta

Key Reference 4

Accesses the marker control softkeys that select the type and
number of markers. Markers are diamond-shaped characters
that identify points of traces. Up to twelve pairs of markers
may appear on the display simultaneously; only one pair can
be controlled at a time.

Selects one of the twelve possible markers. A marker that
has already been selected will become active. If a marker has
been turned on and assigned to a specific trace, it will be
active on that trace when selected.

Key access: @

Activates a single frequency marker at the center of the
active trace if a marker is not already displayed.

Displaying a marker before enabling the Normal function
enables the marker at the position of the selected marker.
The marker number shows above the marker. The knob
and/or arrow keys move the marker left or right. Entering a
value from the numeric keypad moves the marker to the
trace point nearest to that value. Annotation in the active
function block and in the upper-right corner indicates the
frequency and amplitude of the marker (time and amplitude,
if in zero span.) Pressing Normal turns off the Delta function
and moves the active marker to the delta marker position.

Key access: @

Accesses the submenu to use the marker delta function.

Key access: @

Delta Delta (On) activates a second marker at the

On Off position of the first marker. If no marker is
present, two markers appear at the center of
the display. The amplitude and frequency (or
time) of the first marker is fixed. The marker
number is indicated above the delta marker,
and the same number is indicated with an R
(for example, 1R) above the reference marker.
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Use the data control keys to position the delta
marker. Annotation in the active function block
and in the upper-right corner indicates the
frequency/time and amplitude differences
between the two markers. Delta (0ff) moves the
reference marker to the active marker position,
allowing you to make delta measurement from
differing reference points without having to turn
off the markers and begin again.

Key access: @ > Delta

Delta Pair Toggles the Delta Pair between the reference

Ref Delta (start) and delta (stop) markers. The start
marker number is indicated with a number and
an R above the marker (for example, 1R) and the
delta marker is indicated with a marker number.

Key access: m > Delta

Span Pair Toggles the Span Pair function between the span

Span Center and center markers. The start marker number is
indicated with a number and an R above the
marker (such as 1R) and the stop marker is
indicated with a marker number. Adjusting the
span changes the frequency difference between
the two markers while maintaining the midpoint
between the two markers at a fixed frequency.
Changing the center changes the center point
between the two markers while maintaining the
frequency difference.

Key access: w > Delta

Ref and Delta markers maintain their displayed x-axis location, but not
their frequency values when you change a parameter that redefines
the x-axis scale. Reset these markers when parameters such as Span
or Center Freq are changed.

Off Turns off the selected marker by the Select Marker key. Off
also turns off the related functions such as signal track. It
also removes marker annotation from the display.

Key access: @
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Turns off all of the markers, including markers used for
signal track. This also removes marker annotation.

Key access: w
Accesses the marker function softkeys listed below.

Key access: w

Freq Accesses the frequency counter function.
Counter Key access: M > Function

Freq Counter Toggles the frequency counter
On Off function between on and off.
Key access: M > Function > Freq Count

Resolution Toggles the frequency counter

Auto Man resolution between manual and
auto-couple. The allowed values are
0.1, 1, 10, 100 Hz and 1 kHz. Pressing
Auto auto-couples this resolution to
the span.
Key access: M > Function > Freq Count

The ratio of the resolution bandwidth to span must be greater than
0.02 for the frequency counter to work properly. Frequency counter
properly only on CW signals or discrete peaks. For a valid reading, the
marker must be >40 dB above the noise.

Phase Accesses the phase noise function softkeys.
Noise  Key access: [[fy] > Function

Phase Noise Toggles the phase noise function
On Off between on and off.
Key access: [[Hfy > Function > Phase Noise

Offset Sets the offset of marker manually to
Manual measure phase noise.

Key access: [[Hfy > Function > Phase Noise
Offset Sets the offset to +1, +10, +20, +30, +50,

+100 kHz or +1 MHz.
Key access: [[Hfy > Function > Phase Noise
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Maker Trace
Auto1234

Marker Table

Optimize This softkey is valid only when span fall in the
Phase Noise range of 100 Hz and 100 kHz. Once enable this
softkey, 1st LO Loop filter bandwidth will be
changed from 5 kHz or so to 120-150 kHz
automatically, which optimizes the phase noise
close in to the carrier.
Key access: @ > Function > Phase Noise

Optimize Phase noise (On) will worsen phase noise far away from the
carrier. If you pay more attention to phase noise far away from the carrier,
select Optimize Phase noise (Off).

For more details on how to measure the phase noise of a
signal, please refer to “Measuring Phase Noise” on page 53.

Activates a marker on the trace if there are no markers
turned on. If a marker is currently active, press Marker Trace
until 1, 2, 3, or 4 is underlined: the active marker moves to
the selected trace.

Selecting Auto mode moves the marker to the automatically
selected trace. The trace selection is to look for the lowest
numbered trace in the following mode order: Clear-write,
Max-hold, Min-hold and View. If there are no traces in any of
these modes, it selects trace 1.

Key access: @ > More

Compresses the graticule and displays marker information in
a table. The information includes the marker number, trace
number, marker type, X axis value, and the amplitude.

Key access: m > More

On Activates/deactivates the marker table.
off Key access: [y > More > Maker Table

Prev Page displays the previous/next page of the marker

Next Page  table.
Key access: @ > More > Maker Table
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Mkr—CF

Mkr— CF Step

Mkr — Start

Mkr— Stop

Mkr — Ref Lel
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Press accesses the following marker function softkeys:

Sets the frequency of the marker to the center frequency. In
delta mode, Mkr—CF sets the center frequency to the
marker delta value. Mkr—CF is not available in zero span.

Key access:

Changes the center-frequency step size to match the value of
the active marker. Press [ > CF Step to view the step
size. The step size is the frequency difference between the
markers when marker delta is active. Use this function to
step from one signal harmonic to another. Mkr— CF Step is
not available in zero span.

Key access:

Changes the start frequency so that it is equal to the
frequency of the active marker. In delta mode, Mkr— Start
sets the start frequency to the marker delta value.

Mkr— Start is not available in zero span.

Key access:

Changes the stop frequency so that it is equal to the
frequency of the active marker. In Delta mode, Mkr— Stop
sets the stop frequency to the marker delta value. Mkr— Stop
is not available in zero span.

Key access:

Changes the reference level to the active marker value,
moving the marked point to the reference level (top line of
the graticule). In delta mode, Mkr— Ref Lel sets the reference
level to the amplitude difference between the markers. (For
example, if the difference is —15 dB, the reference level -15
dBm.)

Key access:
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Meas

98

In the Spectrum Analyer mode (see MODE), Meas key displays a
menu for measurements such as adjacent channel power,
occupied bandwidth, channel power, spectrum emission mask
and TOI. Refer to Chapter 5, “One-Button Measurements” for
more information about these measurements. Press Measure
Off to turn the measurement off.
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Selects the measurement mode of your analyzer.
Spectrum Analyser mode is the default mode and is for general
purpose measurement use. .

Selects the spectrum analysis measurement mode for your

Accesses the tracking generator functions. (Option TG3)

Spectrum
Analyzer analyzer.
Key access: w
Tracking
Generator

Amplitude TG
On Off

Attenuation

Amptd Offset
On Off

N9320A Spectrum Analyzer

Key access: M

Activates (0n) or deactivates (0ff) the output
power of the tracking generator. The power
level can then be adjusted using the numeric
keypad, arrow keys or knob. Pressing any
digit, 0 through 9, on the numeric keypad
brings up the selected terminator menu. The
output level range is -30 dBm to 0 dBm.
Key access: m > Tracking Generator

Allows you to set the output attenuation
level of the tracking generator in the inner
attenuator. The available level is 0 to 30 dB
in 6 dB steps.The default setting is 18 dB.
Key access: m > Tracking Generator

Amptd Offset (On) allows you to offset the
displayed power of the tracking generator.
Using the amplitude offset capability of the
tracking generator allows you to take system
losses or gains into account, thereby
displaying the actual power delivered to the
device under test.

Key access: m > Tracking Generator
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Amptd Step Allows you to set the step size of the power level
range of the tracking generator. The default setting is
one vertical scale division when in a logarithmic
amplitude scale.

Key access: @ > Tracking Generator

Auto Man

Power
Sweep

Normalize

Sweep the output offset of the tracking generator.
The analyzer continues to sweep the linear change
between strat and stop frequency when power sweep
is on. The input range is 0 dB to 10 dB.

Key access: > Tracking Generator>More

Accesses the following softkeys.

Store Ref
(1->3)

Normalize
On Off

Copies trace 1 into trace 3. Store Ref
(1->3) must be pressed before pressing
Normalize (On).

Key access: @ > Tracking Generator >
More > Normalize

Activates the normalize function. On
each sweep, the normalized trace (Trace
3) is subtracted from Trace 1 and the
result is added to the normalized
reference level.

The trace data is normalized with
respect to the normalized reference level,
even if the value of the normalized
reference level is changed. This function
remains in effect on all subsequent
sweeps until it is turned off.

The normalize function is most useful for
applying correction data to a trace while
making a stimulus response measurement

Trace 1 should be in clear write mode prior to setting normalize to on.
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Norm Ref Lvl

Norm Ref
Posn

Key Reference 4

with a tracking generator. For example,
connect the cables and a thru line, in place
of the device to be measured, between the
tracking generator and the analyzer input.
Notice that the frequency response is not
perfectly flat, showing the response of the
cables, as well as the flatness of both the
tracking generator and the analyzer. Now
press Store Ref (1->3), Normalize (On). Notice
that the displayed trace is now flat, or
normalized. The position of the normalized
trace can now be moved to a different
position on the display by changing the
normalized reference position. This may be
useful if the device to be tested has
positive gain, such as an amplifier. Now
replace the thru line with the device under
test, and an accurate measurement of the
gain or loss can be made.

Key access: @ > Tracking Generator > More
> Normalize

Sets the level (in dB) of the normalized
reference.

Key access: @ > Tracking Generator > More
> Normalize

Offsets the displayed trace without affecting
the instrument gain or attenuation settings.
This allows the displayed trace to be moved
without decreasing measurement accuracy.
The normalized reference position is
indicated with a (>) character on the left
side of the display and a (<) character on
the right side of the display.

Key access: m > Tracking Generator > More
> Normalize
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Tracking
Peak

Man Track
adj

Ref Trace Allows you to view or blank the reference
View Blank trace on the display.
Key access: w > Tracking Generator > More
> Normalize

Activates a routine that automatically adjusts fine
frequency tracking to obtain the peak response of the
tracking generator on the spectrum analyzer display.
Tracking Peak is performed in the current resolution
bandwidth.

Key access: w > Tracking Generator>More

Allows you to adjust the frequency of the tracking
generator oscillator manually using the step keys, knob,
or numeric keypad. The tracking adjust is tuned to
maximize the amplitude of the trace.

Key access: w > Tracking Generator>More

When in the Tracking Generator mode, resolution bandwidths < 1 kHz
are not available.
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Peak Search

Next Peak

Next Pk Right

Next Pk Left
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Key Reference 4

Places a marker on the highest peak based on the settings of
the “Search Criteria” on page 104. Refer to “Peak Search

Type” on page 105, for more information on the effect of
settings.

All peak search functions ignore the LO feed through. The process for
determining if the Peak is the LO feed through takes into account Start
Frequency, Span, Resolution Bandwidth, Resolution Bandwidth shape
factor, and Frequency Accuracy. If there is no point of inflection within the
LO feed through range, the point on the trace with maximum amplitude,
that is higher in frequency than the LO feed through, will be selected.

Performs peak search as described above.
B Peak
Key access:

Places the marker on the next highest peak. The signal peak
must exceed the peak threshold value by the peak excursion
value. If there is no peak, the marker will not move.

N Peak
Key access:

Moves the marker to the next peak to the right of the
current marker. The signal peak must exceed the peak
threshold value by the peak excursion value. If there is no
peak to the right, the marker will not move and the “ No
Peak Found ” error message will appear on the display.

B Peak
Key access:

Moves the marker to the next peak to the left of the current
marker. The signal peak must exceed the peak threshold
value by the peak excursion value. If there is no peak to the
left, the marker will not move and the “No Peak Found” error
message will appear on the display.

. I
Key access:
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Min Search

Pk-Pk Search

Continuous Pk
On Off

N dB Points
On Off

Search Criteria

Moves the active marker to the minimum detected amplitude.
Key access:

Finds and displays the frequency (or time, if in zero span)
and amplitude differences between the highest and lowest
trace points.

N Peak
Key access:

When a marker is placed on a signal and Continuous Pk is on,
the marker will remain on the signal even if the frequency
changes, as long as the amplitude of the signal does not
change by more than 3 dB from one sweep to another.

If the signal is lost, the marker will attempt to find it again
and maintain on the peak. If there are other signals on

screen near the same amplitude, one of them may be found
instead. Signals near 0 Hz cannot be maintained effectively.

This function is intended to maintain the marker on signals
with a frequency that is changing, and an amplitude that is
not changing.

Key access: 2| > More

Activates the N dB function. Pressing N dB Points (On)
activates two arrows that are N dB down from the marker.
The frequency difference between the two arrows will be
displayed in the upper right-hand corner of the display.

Key access: §&38 > More

Search

Accesses the submenu to set the criteria for peak search.

M Peak
Key access: i3 > More
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Peak Excursion Sets the minimum amplitude variation of
signals that the marker identifies as a peak.
If a value of 10 dB is selected, the marker
moves only to peaks that rise and fall more
than 10 dB above the peak threshold value.
When the peak excursion is 6 dB of higher,

Two signal peaks, which are so close together that the amplitude drop
between them is less than the peak-excursion value, are not
recognized as two peaks. A signal peak is recognized only if it has a
peak excursion drop above the noise floor, on both sides of the signal.

the marker- peak do not recognize signals less
than peak-excursion value above the noise
floor. To correct this, when measuring signals
near the noise floor, reduce the excursion
value. To prevent the marker from identifying
noise as signals, reduce the noise floor
variance less than the peak-excursion value
by reducing the video bandwidth or by using
video averaging.

Key access: [ > More >Search Criteria

Search

Peak Sets the minimum amplitude that the marker
Threshold can identify as a peak. For example, if set to
-90 dBm, the marker moves only to peaks
that rise and fall more than the peak
excursion above -90 dBm.
Key access: [ > More > Search Criteria

Search
Threshold Hides the threshold line.
Hidden Key access: g_:jgir‘_; > More > Search Criteria
Peak Search Selects the peak search mode.
Type Key access: %3 > More > Search Criteria
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Peak Table

Max Value A Peak search with Max Value type
places a marker on the highest
peak, excluding the LO
feedthrough peak.

Key access: &3 > More > Search

Search

Criteria > Peak Search Type

Excursion & When Peak Search Type is Excursion &

Threshol  Threshold, a peak search places a
marker on a peak that meets the
Peak Excursion and Peak Threshold
parameters. If Peak Search Type is
Excursion & Threshold and no peak
satisfies the selected parameters, a
marker is placed at the center of
the trace, and the error message,
“No Peak Found” will appear.
Key access: ;Eé;',‘:l > More > Search

Criteria > Peak Search Type

Accesses the following Peak Table softkeys to set a peak table.

Key access:

Peak Table
On Off

Peak Sort
Freq Amptd

S > More

Displays a list of up to 12 signal peaks that is
updated at the end of each sweep. The peak
table function works with trace 1 only.

Key access: > More > Peak Table

Switches the peak table sorting routine
between listing the peaks in order by
descending amplitude or frequency.

Key access: [&38 > More > Peak Table

Search
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Accesses the Preset and System softkeys. When the analyzer
is in the remote mode, pressing returns the analyzer
to the local mode and enables front- panel control.

Provides a known state of the instrument for making
measurements. The analyzer allows you to select whether a
user preset, or factory preset is performed.

If Preset Type is set to Factory, pressing > Preset performs
a factory preset, which performs the following;:

* Resets the analyzer to Spectrum Analyzer (SA) mode
¢ Brings up the Frequency menu
¢ Sets certain conditions to their default values

¢ (Clears both the input and output buffers and clears all
trace data

¢ Sets the amplitude values of trace 2, 3 and 4 to the
bottom of the screen

¢ Turn amplitude- correction factors off, but remain in
analyzer memory

e Turn limit line testing off, but the limit line tables remain
in analyzer memory

See Table Factory Preset States as follows for the conditions
established by performing a factory preset.

When Preset Type is set to User, pressing > Preset
displays the softkeys User Preset and Factory Preset, you then
select the specific preset as you need.

Key access:
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Factory Preset State

Attenuation 20 dB(Auto) Average Type Video (Auto)
Center frequency 1.5 GHz Averaging 1(0ff)

CF step size 300 MHz Peak Excursion 6 dB

Start Frequency 0 Hz Peak Threshold -90 dBm
Stop Frequency 3 GHz Peak Search Type Max Value
Signal Track Off Peak Table Off

Span 3 GHz Peak Sort Amplitude
Reference level 0 dBm Continuous Pk off

Log scale/Division 10 dB Delta Pair Delta

Int Preamp off Span Pair Center
Trace 1 Clear Write Trigger Free Run
Trace 2, 3,4 Blank Markers Normal(Off)
Sweep Time 100.2 ms(Auto) Marker Delta Off

Sweep Continuous Marker Table Off

Limit Off Measure Meas Off
Limit line testing Off File Catalog Local

Limit point 0 File Type State
Detector Peak(Auto) File Sort By Date
Display line -25 dBm(0ff) Phase Noise Off

Video bandwidth 3 MHz(Auto) Optimize phase noise | Off
VBW/RBW ratio 1.000 (Auto) Frequency Counter Off
Resolution 3 MHz(Auto) Frequency counter 1 kHz(Auto)
bandwidth resolution
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Pwr on/Preset

Alignment

N9320A Spectrum Analyzer

Key Reference 4

Accesses the following softkeys for the preset settings.
Key access:

Power on Determines the state of the analyzer when the

Last Preset analyzer is turned on. Power On set to Preset
recalls the analyzer settings previously with the
Preset function. Power On set to Last recalls the
analyzer settings when previously power off.

Key access: RN > Pwr on/Preset

System

Preset Type  Selects User or Factory preset settings.
Key access: R#EN > Pwr on/Preset

System

User Pressing Preset recalls the analyzer
settings defined by Save User Preset.
Key access: [l > Pwr on/Preset >
Preset Type

Factory Pressing Preset recalls the analyzer
settings originally set at the factory.
Key access: {6 > Pwr on/Preset >

stem

Preset Type
Save User Saves the active settings of the analyzer into
Preset the User Preset register. To recall these settings,

select Preset Type to User.

Key access: &4l > Pwr on/Preset
Accesses the following softkeys that align the internal
circuitry of the analyzer, load default values for the
alignment system, and adjust the 10 MHz reference.

Key access:

Align Accesses the Align softkeys.
Key access: > Alignment

All Initiates the alignment of systems
(Ext Cable) with a cable connected from the CAL
OUT to RFIN (Except option TG3).

Key access: ;;g;’, > Alignment > Align

109



4

110

Key Reference

Language

Diagnostics

Show System

Show
Hardware

Show
Software

CALOUT Turns the internal amplitude

On Off reference signal on or off. When this
signal is on, the RF input is disabled.
Key access: > Alignment > Align

Timebase verifies the settability of the 10 MHz reference
and to adjust for changed operating conditions,
such as temperature.

Key access: > Alignment

Load Default Loads the default values for the alignment
system, turns on the frequency corrections, and
resets the timebase to the factory values.

Key access: [[&#l > Alignment

Accesses the softkeys for selecting the screen menu language.
Key access:

Accesses the Front Panel Test softkey to verify the functionality
of each front-panel key. The number next to each key name
increments once each time the key is pressed. Rotating the
knobs causes the number of pulses to be counted. Press
Return will go back to the main menu.

Key access:

Displays the number and description of the options installed
in your analyzer. It also displays the instrument model
number, product number, serial number, the date of
production, etc.

Key access: s;m“ > More

Provides detailed information about the hardware installed
on your analyzer, including the model number and firmware
revision.

Key access: @ > More
Provides detailed information about the software installed on

your analyzer.
Key access: ngij > More
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Show Errors

Time/Date

N9320A Spectrum Analyzer

Key Reference 4

Accesses a list of the last 100 errors reported. The most
recent error will appear at the bottom of the list. The first
error listed will be removed firstly if the error list is longer
than 20 entries. If the same error occurs continuously, the
same error message will not be added to the list. Refer to
“Instrument Messages” on page 135 for details.

Key access: [Heg! N > More

PrevPage/  Access the previous/next page of error
Next Page messages.
Key access: {8l > More > Show Errors

Clear Error Clears all the errors in the errors queue.
Queue Key access: [l > More > Show Errors

Accesses the following Time/Date menu keys used to set and
display the real-time clock:

Key access: s;eseﬂ > More

Time/Date Toggles the time/date display between on and
On Off off.
Key access: {48l > More >Time/Date

Date Format Changes the display format of date from
MDY DMY month-day-year to day- month-year.
Key access: s;"““ > More > Time/Date

Set Time sets the time of the real-time clock. Enter the
time in 24 hour HHMMSS format. Valid hour
(HH) values are from 00 to 23. Valid minute
(MM) and second (SS) values are from 00 to 59.
Key access: [l > More > Time/Date

Set Date sets the date of the real-time clock. Enter the
date in the YYYYMMDD format. Valid year
(YYYY) values are 0000 through 9999. Valid
month (MM) values are from 01 to 12, and
valid day values are from 01 to 31.
Key access: @ > More > Time/Date
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Key Reference

Licensing

Brightness

Accesses the security system to enable licensing for
individual options. There is no way to turn off an option
through this system. Once an option has been licensed for a
given analyzer, it cannot be transferred to a different

analyzer.

Key access: &l > More > More

Option

License Key

Activate
License

Allows you to key in a three-character option
number. The option number will appear on the
second line of the Option key.

Key access: > More > More > Licensing

Allows you to key in a license key number.
The license key number appears on the second
line of the License Key softkey.

Key access: > More > More > Licensing

Activates the option whose number you
previously keyed in License Key. If your entry is
correct, the option will be enabled and the
message: “Option activated” will appear in the
status line of your display. The option number
and license key numbers will also clear from
the License Key and Option key.

If your entry is incorrect, the error message
“License key invalid” appears in the status line of
the display. Edit the option number and
license key number until they are correct.
Key access: > More > More > Licensing

Adjusts the brightness of the display from 1% to 100%.
Key access: '%_Tg}’n > More > More
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SPAN

Span

Full Span

Zero Span

Last Span

N9320A Spectrum Analyzer

Key Reference 4

Activates the span function and accesses the submenu of
span functions. Pressing [0 changes the frequency range
symmetrically about the center frequency. The
frequency-span readout describes the total displayed
frequency range. To determine frequency span per horizontal
graticule division (when the frequency scale type is set to
linear), divide the frequency span by 10.

Enters a span frequency range value.

Key access: §EL

Changes the span to full span showing the full frequency
range of the analyzer. Full span sets Signal Track, Marker
function off.

Key access: §ELN

Changes the frequency span to zero. In this mode, the
current center frequency is displayed in the time domain
(the x-axis is displayed in units of time), like a conventional
oscilloscope. Zero span sets Signal Track (Off).

Key access: (B2

Changes the span to the previous span setting.

Key access: (B0
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Sweep/Trig

114

Sweep Time
Auto Man

Sweep
Single

Sweep Cont

Accesses the following softkeys to provide selection of the
sweep mode and trigger mode of the analyzer:

Selects the length of time the analyzer takes to tune across
the displayed frequency span (or, in zero span, the time the
analyzer takes to sweep the full screen). Reducing the sweep
time increases the sweep rate. Change the sweep time by
using the arrow keys, the knob, or the numeric keypad.

In non-zero spans, when the sweep time is auto- coupled, the
analyzer selects the optimum (shortest) sweep time for the
current settings. This selection process is influenced by
several factors:

* The max. tuning rate of the spectrum analyzer

e The selected resolution and video bandwidth filters

¢ The max. sample rate of the analog-to-digital converter
¢ The number of trace points

¢ The amplitude scale (logarithmic or linear)

* The detector mode

You may select a sweep time less than the auto-coupled
value; however this may generate measurement errors. The
minimum sweep time is 50 ms.

In zero span, the minimum sweep time is determined by the
maximum sample rate of the ADC and the number of sweep
points. The minimum sweep time is 2 microseconds. The
maximum sweep time is 4000 seconds.

N Sweep]
Key access:

Pressing Sweep Single puts the analyzer in single-sweep
mode. Press Sweep Single to initiate a sweep when in
single- sweep mode.

e
Key access:

causes one sweep to follows another as soon as it is
triggered. Pressing Preset (When Preset Type is set to Factory)
sets the sweep mode to continuous sweep.

N Sweep]
Key access:
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Free Run

Video

External Pos

External Neg

Trig Offset

N9320A Spectrum Analyzer

On Off

Key Reference 4

New sweep starts as soon as possible after the current
sweep ends.

Key access: Bl > More

Activates the trigger condition that starts the next sweep if
the detected RF envelope voltage rises to a level set by the
video trigger level. When Video is pressed, a line appears on
the display. The analyzer triggers when the input signal
exceeds the trigger level at the left edge of the display.
Change the trigger level by using the arrow keys, the knob,
or the numeric keypad.

Key access: [l > More

This function is not available when the Resolution Bandwidth is less
than 1 kHz. Selecting a Resolution Bandwidth less than 1 kHz while in
Video Trigger mode, changes the Trigger mode to Free Run.

Activates the trigger condition that start the next sweep
when the external voltage (connected to EXT TRG IN on the
rear panel) passes through approximately 2 volts. The
external trigger signal must be a 0 V to +5 V TTL signal. Set
the trigger polarity to positive.

Key access: 5 > More

Sets the trigger polarity to negative.

Key access: |5l > More

Allows you to set and turn on or off an offset value from
the trigger point of the sweep at which to begin storing data
in the trace of the analyzer. The offset is specified as a
function of time, and permits positive (pre trigger) and
negative (post trigger) values to be specified.

Key Access: [BZZN > More

This function is only available when in Zero Span. The value and state is
saved if Zero Span is exited and restored when Zero Span is reselected.
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View/Trace

116

Select Trace
1234

Clear Write

Max Hold

Min Hold

View

Blank

Accesses the trace keys to store and manipulate trace
information. Each trace consists of a series of points in
which amplitude data is stored. The analyzer updates the
information for any active trace with each sweep.

Selects the trace for current use.
Key access: W

Trace_
Erases any data previously stored in the selected trace, then
continuously displays any signals during each sweep of the
analyzer. This function is activated for trace 1 at power-on
and Factory Preset.

N View]
Key access:

Retains the maximum level for each trace point of the
selected trace, and updates each trace point if a new
maximum level is detected in successive sweeps.

Key access: T";ﬂ

Retains the minimum level for each trace point of the
selected trace, and updates each minimum trace point if a
new minimum level is detected in following sweeps.

N View]
Key access:

Holds and displays the amplitude data of the selected trace.
The trace register is not updated as the analyzer sweeps.
press View to retrieve a stored trace previously deactivated
by pressing Blank.

Key access: T";ﬂ

Stores the amplitude data for the selected trace, then
removes the trace from the display. The selected trace
register no longer updates as the analyzer sweeps. To
activate this function for traces 2, 3 and 4 at power-on press
Preset (when Preset Type is set to Factory).

N View]
Key access:
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Agilent N9320A Spectrum Analyzer
User's Guide

)
One-Button Measurements

Channel Power 118
Occupied BW 120
ACP 123

Intermod (TOI) 126

Spectrum Emission Mask 128

This chapter provides you with functional descriptions of all

available measurements when you press the front-panel
m hardkey (Spectrum Analyer is selected).

We assume that you understand the front and rear panel
layout, and display annotations of the analyzer. If you do

not, please refer to “Agilent N9320A at a Glance” on page 2.

Agilent Technologies
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One-Button Measurements

Channel Power

118

Active Function
Area

Measurement
Result

Channel Power measures the power and power spectral
density in the specified channel bandwidth. One white frame
on the display indicates the edges of the channel bandwidth.
You need to set the center frequency, reference level, and
channel bandwidth.

The power calculation method used to determine the channel
power is a traditional method known as the integration
bandwidth (IBW) method. A swept spectrum is used as the
basis for this calculation. Therefore, it is important to set
the resolution bandwidth correctly before making this
measurement using the following formula:

RBW = (k(span))
n

Where k is a value between 2 and 6 and n=461 is the
number of trace points.

Figure 28 Channel Power Measurement

10-27-2006
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One-Button Measurements 5

Avg Number  Specifies the number of measurement averages used when
On Off calculating the measurement result with Avg Number (On). The
range of the number is from 1 to 1000. Use the knob, the
arrow keys or the numeric keypad to set the number. The
average will be displayed at the end of each sweep. Selecting
Off disables measurement averaging.

Key access: m > Channel Power

Avg Mode Toggles the average mode between Exp or Repeat. This
Exp Repeat determines the averaging action after the specified number
of measurements (average count) is reached.

When you select Exp, each successive data acquisition after
the average count is reached is exponentially weighted and
combined with the existing average. Exponential averaging
weights new data more than old data, which facilitates
tracking of slow-changing signals. The average will be
displayed at the end of each sweep.

If you select Repeat, after reaching the average count, all
previous data is cleared and the average count is back to 1.

Key access: m > Channel Power

Integ BW  Specifies the range of integration used in calculating the
power in a channel. For example, set the main (center)
channel bandwidth. Note that the white frame indicates the
integration bandwidth. Be sure the span is set between 1
and 10 times the integration bandwidth. Change integration
bandwidth by using the knob and the arrow keys.

Key access: m > Channel Power

Chan Pwr Span  Sets the analyzer span for the channel power measurement
by using the knob and the arrow keys. Be sure the span is
set between 1 and 10 times the integration bandwidth.

Key access: m > Channel Power
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b One-Button Measurements

Occupied BW

Measurement
Result

120

Occupied Bandwidth integrates the power of the displayed
spectrum. The power-bandwidth routine first computes the
power of all signal contained in the trace, then calculates
the span which contains the power of a selected percentage.
The percentage value defaults to 99% of the occupied
bandwidth power.

For 99% occupied power bandwidth, Markers are placed at
the frequencies on either side of 99% of the power. 1% of the
power is evenly distributed outside the markers. The
difference between the marker frequencies is the 99% power
bandwidth.

This is the main menu of occupied bandwidth measurement
including all related parameters and measurement results.

Figure 29  Occupied Bandwidth Measurement

10-27-2005
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The occupied bandwidth function also indicates the
difference between the analyzer center frequency and the
center frequency of the channel. This “Transmit Freq Error”

N9320A Spectrum Analyzer



Avg Number
On Off

Avg Mode
Exp Repeat

Max Hold
On Off

Occ BW% Pwr

N9320A Spectrum Analyzer

One-Button Measurements 5

is defined as the difference between the (fi1 + f2)/2 and the
tuned center frequency of the signal.

To get the right measurement result, you need to set the center frequency,
reference level, and channel spacing first.

Select On to specify the number of measurement averages
used when calculating the measurement result. The average
is displayed at the end of each sweep. Select Off to disable
measurement averaging. The range is from 1 to 1000.

Key access: @ > Occupied BW

Toggles the termination control type used for the averaging
function between Exp and Repeat. This determines the
averaging action after the specified number of measurements
(average count) is reached.

When you select Exp, each successive data acquisition after
the average count is reached is exponentially weighted and
combined with the existing average. Exponential averaging
weights new data more than old data, which facilitates
tracking of slow-changing signals. The average is displayed at
the end of each sweep.

When you select Repeat, after reaching the average count, all
previous data is cleared and the average count is back to 1.

Key access: @ > Occupied BW

Toggles the maximum hold trace feature between On and Off.
Maximum hold displays and holds the maximum responses
of a signal.

Key access: @ > Occupied BW

Edits the percentage of signal power used when determining
the occupied bandwidth.

Key access: @ > Occupied BW
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One-Button Measurements

0BW Span

x dB

Specifies the range of integration used in calculating the
total power from which the percent occupied bandwidth is
then calculated. The analyzer span will be set to the same
value as the OBW Span for the measurement. OBW Span
should be set to approximately 2 times the expected occupied
bandwidth result. The range is from 100 Hz to 3 GHz.

Key access: > Occupied BW

Specifies the power level used to determine the emission
bandwidth as the number of dB down from the highest
signal point, within the occupied bandwidth span. This
function is an independent calculation from the OBW
calculation. The x dB Bandwidth result is also called the
emissions bandwidth, or EBW. This will set two arrows to
your specified dB value below the maximum power and
compute the total power between the arrows. Frequencies f1
and f2 are determined as the furthest frequencies x dB
below and above summit, respectively. The emission
bandwidth is then calculated as f2 - f1 as shown by the
arrows indicated in Figure 29 (note that the diamond
markers are for the OBW function). The range is from -100.0
to -0.1 dB.

Key access: @ > Occupied BW

The asterisk next to the x dB bandwidth value in Figure 29 indicates
the results may not have been determined with optimal analyzer
settings. If emission bandwidth is your primary interest, select Max
Hold. Then change detector mode to peak by pressing >
Detector > Positive Peak. Acquiring peak data ensures accuracy of
this measurement.
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ACP

Avg Number
On Off

Avg Mode
Exp Repeat

N9320A Spectrum Analyzer

One-Button Measurements b

Adjacent Channel Power (ACP) measures the power present
in adjacent transmit channels. The span is automatically set
according to the six available offsets and their associated
integration bandwidths defined by you.

Figure 30  Adjacent Channel Power Measurement

14:09:42 10-2T-2006
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Pressing On specifies the number of measurements that will
be averaged when calculating the measurement result. The
average will be displayed at the end of each sweep. Pressing
Off disables the measurement averaging.

Key access: @ > ACP

Enables you to select the type of termination control used
for the averaging function (Exp or Repeat). This determines
the averaging action after the specified number of
measurements (average count) is reached.

When you select Exp, each successive data acquisition after
the average count is reached is exponentially weighted and
combined with the existing average. Exponential averaging

123



5

124

One-Button Measurements

Chan Integ BW

Offset/Limits

weights new data more than old data, which facilitates
tracking of slow-changing signals. The average is displayed at
the end of each sweep.

When you select Repeat, after reaching the average count, all
previous data is cleared and the average count is back to 1.

Key access: m > ACP

Specifies the range of integration used in calculating the
power in the main channel. Use the knob and the arrow
keys to set the bandwidth.

Key access: m > ACP

Accesses softkeys that allow you to configure the offsets for

the ACP measurement.

Key access: [[[33] > ACP

Offset Selects the offset the softkeys will affect. Press

ABCDEF Offset until the letter of the desired offset is
underlined.

Key access: [[fZ1 > ACP > Offset/Limits

Offset Freq Sets the frequency difference from the center
On Off of the main channel to the center of the offset
for a maximum of 6 offsets (labeled A-F). It
also allows you to turn On/0ff the offsets that
you want to measure.
Key access: [[fZ1] > ACP > Offset/Limits

Ref BW Sets the reference bandwidth (integration
bandwidth) for each offset.
Key access: m > ACP > Offset/Limits

Pos Offset Sets the upper limit for the upper segment of
Limit the specified offset pair.
Key access: [[[Z1] > ACP > Offset/Limits

Neg Offset Sets the upper limit for the lower segment of
Limit the specified offset pair.
Key access: m > ACP > Offset/Limits
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Meas Type

Method
IBW RBW

Total Pwr Ref
(PSD Ref)
Auto Man

N9320A Spectrum Analyzer

Limits
On Off

One-Button Measurements 5

Specifies the reference for the measurement, either Total Pwr
Ref or PSD Ref. Relative values are displayed referenced to
either the total power (Total Pwr Ref) or the power spectral
density (PSD Ref) measured in the main channel.

Key access: @ > ACP

Enables you to select the measurement method. The
resolution bandwidth (RBW) method is most useful for
measuring cdmaOne signals; the integration bandwidth
method (IBW) is preferred for other signals.

Key access: @ > ACP > More

Sets the adjacent channel power reference to automatic or
manual when Meas Type is set to Total Pwr Ref . When select
Auto, the carrier power result reflects the measured power
value in the carrier. When set to Man, the last measured
value is captured and held, or may be entered by the user.
Relative values are displayed, referenced to the total power
measured in the main channel.

when Meas Type is set to PSD Ref, pressing this key sets the
power spectral density in the carrier (main channel) that
will be used to compute the relative power spectral density
values for the offsets.When the PSD Ref state is set to Auto,
this will be set to the measured carrier power spectral
density.

Key access: m > ACP > More

Turns the testing of the limits on or off. When select On,
each offset is compared to its upper and lower offset limit.
In those cases where the power exceeds the limit, the
calculated result will be displayed in red to indicate a
failure. If there are any failures, the pass/fail indicator area
show “FAIL” in red; if there are none, it shows “PASS” in
green when using IBW method. Neither “FAIL” nor “PASS” will
be displayed when using RBW method. Any offsets that are
in the off state are not measured and their results will not
be displayed on screen.

Key access: @ > ACP > More
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One-Button Measurements

Intermod (TOI)

126

Avg Number
On Off

Avg Mode
Exp Repeat

The third order intermodulation (TOI) measurement computes
and displays the output intercept point (IP3), and places
arrows upon the trace to indicate the measured signals and
third- order products.

Figure 31 TOI Measurement
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Set Avg Number to On to specify the number of measurement
averages used when calculating the measurement result. The
average will be displayed at the end of each sweep. Setting
Avg Number to Off disables measurement averaging.

Key access: @ > More> Intermod (TOI)

Selects the type of termination control used for the averaging
function (Exp/Repeat). This determines the averaging action
after the specified number of measurements (average count)
is reached.

When Avg Mode is Exp, Each successive data acquisition after
the average count is reached is exponentially weighted and
combined with the existing average. Exponential averaging
weights new data more than old data, which facilitates
tracking of slow-changing signals. The average is displayed at
the end of each sweep.
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TOI Span

Max Mixer Lvl
Auto Man

N9320A Spectrum Analyzer

One-Button Measurements 5

When Avg Mode is Repeat, after reaching the average count, all
previous data is cleared and the average count is back to 1.

Key access: m > More> Intermod (TOI)

Specifies the frequency span in which intermodulation
products are measured. If you modify the value of span in
the base instrument Span menu, the value in the Intermod
(TOIl) menu will be updated to reflect the new value, and the
measurement will restart if it is running.

Key access: m > More> Intermod (TOI)

Sets the relationship between the highest signal that can be
displayed (the reference level) and the input attenuation. The
relationship applies whenever the Attenuation is set to Auto.
The relationship is that the attenuation is given by reference
level minus the max mixer level. For example, as the
reference level changes, the input attenuator changes to
ensure that a signal at the reference level does not exceed
the Max Mixer Lvl setting.

When the TOI measurement is off, the previous maximum
Max Mixer Lvl is restored.

Pressing Auto sets the maximum mixer level to -30 dBm.
Key access: m > More> Intermod (TOI)
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One-Button Measurements

Spectrum Emission Mask

128

Avg Number
On Off

Meas Type

Spectrum Emission Mask measurement includes the in-band
and out-of-band spurious emissions. As it applies to
W-CDMA (3GPP), this is the power contained in a specified
frequency bandwidth at certain offsets relative to the total
carrier power. It may also be expressed as a ratio of power
spectral densities between the carrier and the specified
offset frequency band. For WLAN, the reference power is
taken as the peak PSD in the signal, and all offset results
are also the peak PSD in that offset as opposed to the
integrated power.

Figure 32  Spectrum Emission Mask

jilent 11:08:08

Set Avg Number to On to specify the number of measurement
averages used when calculating the measurement result. The
average will be displayed at the end of each sweep. Setting
Avg Number to Off disables measurement averaging.

Key access: [[[f3] > More > Spectrum Emission Mask
Displays a menu where you can select a measurement

reference type, Total Pwr Ref or PSD Ref.
Key access: @ > More > Spectrum Emission Mask
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Total Pwr Ref

PSD Ref

One-Button Measurements 5

When Total Pwr Ref is selected, the power in the
carrier is used as the reference in computing
the relative power values for the offsets.

Key access: @ > More > Spectrum Emission
Mask > Meas Type

When PSD Ref is selected, the mean power
spectral density of the carrier is used in
computing the relative power spectral density
values for the offsets.

Key access: @ > More > Spectrum Emission
Mask > Meas Type

Ref Channel  Accesses the softkeys that enable you to change the
reference channel settings.

Key access: m > More > Spectrum Emission Mask

Chan Integ BW Specifies the integration bandwidth used in

Chan Span

Sweep Time
Auto Man

Res BW
Auto Man

N9320A Spectrum Analyzer

calculating the power in the main channel.
Key access: > More > Spectrum Emission
Mask > Ref Channel

Specifies the span used in measuring the
power in the main channel.

Key access: m > More > Spectrum Emission
Mask > Ref Channel

Specifies the sweep time used in measuring
the power in the main channel.

Key access: @ > More > Spectrum Emission
Mask > Ref Channel

Specifies the resolution bandwidth used in
measuring and the power in the main channel.
Key access: m > More > Spectrum Emission
Mask > Ref Channel
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Total Pwr Ref  Displays the type of power measurement

(PSD Ref) reference selected by Meas Type.

Auto Man Total Pwr Ref is the power in the carrier that is
used as the reference in computing the
relative power values for the offsets. When
Man is selected, this can be set by the user.
When Auto is selected, this is the measured
power in the reference carrier.

PSD Ref is the mean power spectral density in
the carrier that is used as the reference in
computing the relative power spectral density
values for the offsets. When Man is selected,
this can be set by the user, when Auto is
selected, this is the measured mean power
spectral density in the reference carrier.

Key access: > More > Spectrum Emission
Mask > Ref Channel

Offset/Limits  Displays the menus where you can change the following
parameters for offset frequency settings and pass/fail tests:
Offset, Start Freq, Stop Freq, Sweep Time, Res BW, and Limits. Refer
to the tables below for default settings of particular radio
standards of interest.

Key access: > More > Spectrum Emission Mask

Table1  Offsets & Limits Defaulted for W-CDMA (3GPP) Base Station Measurements?

Offset Start Stop Res BW Abs Abs Abs Rel Rel Stop |Meas
Freq Freq (kHz) Start Stop Couple Start (dBc) BW
(MHz) | (MHz) (dBm) | (dBm) (dBc)
A.On 2515 2.715 30.00 -14.00 -14.00 Couple | -30.00 -30.00 1
B. On 2.7115 3.515 30.00 -14.00 -26.00 Man -30.00 -30.00 1
C.0On 3515 4.000 30.00 -26.00 -26.00 Couple | -30.00 -30.00 1
D.On 4.000 8.000 1000.00 |-13.00 -13.00 Couple |-30.00 -30.00 1
30.00 33
E. On 8.000 12.500 |{1000.00 |-13.00 -13.00 Couple | -30.00 -30.00 1

a. Fail Mask is set to Absolute and Rel Stop is set to Couple.
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Table 2  Offsets & Limits Defaulted for W-CDMA (3GPP) Mobile Station Measurements?

Offset Start Stop Res BW Abs Abs Rel Rel Rel Stop |Meas
Freq Freq (kHz) Start Stop Couple Start (dBc) BW
(MHz) | (MHz) (dBm) |(dBm) (dBc)

A.On 2515 3.485 30.00 -711.07 | -71.07 Man -36.23 -49.78 1
B. On 4.000 7.500 1000.0 -55.84 | -b5.84 Man -35.50 -39.00 1
C.On 7.500 8.500 1000.00 |-55.84 |-55.84 Man -39.00 -49.00 1
D.On 8.500 12.000 |1000.00 |-55.84 |-55.84 |[Couple | -49.00 -49.00 1
E. Off 12500 |15.000 |1000.00 |-55.84 |-55.84 |Couple | -49.00 -49.00 1

a. Abs Stop is set to Couple and Fail Mask is set to Abs AND Rel.

Table 3  Offsets & Limits Defaulted for 802.11a and HiperLAN/2 Radio Standards?®

Offset Start Stop Abs Abs Abs Rel Rel Stop Rel Meas
Freq Freq Start Stop Couple Start (dBc) Couple BW
(MHz) | (MHz) |(dBm) | (dBm) (dBc)
A. On 9.00 11.00 16.00 -4.00 Man 0.00 -20.00 Man 1
B. On 11.00 20.00 -4.00 -12.00 Man -20.00 -28.00 Man 1
C.0On 20.00 30.00 -12.00 -24.00 Man -28.00 -40.00 Man 1
D.On 30.00 50.00 -24.00 -24.00 Couple | -40.00 -40.00 Couple 1
E. Off 50.00 100.00 | -24.00 -24.00 Couple | -40.00 -40.00 Couple 1

a. Res BW is set to 100 kHz and Fail Mask is set to Rel.
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Table 4

132

Offsets & Limits Defaulted for 802.11b Radio Standard?®

Offset Start Freq [Stop Freq |Abs Start |[Abs Stop |Rel Start |Rel Stop Meas
(MHz) (MHz) (dBm) (dBm) (dBc) (dBc) BW

A.On 11.00 22.00 -10.00 -10.00 -30.00 -30.00 1

B. On 22.00 50.00 -30.00 -30.00 -50.00 -50.00 1

C. off 50.00 70.00 -30.00 -30.00 -50.00 -50.00 1

D. Off 70.00 90.00 -30.00 -30.00 -50.00 -50.00 1

E. Off 90.00 100.00 -30.00 -30.00 -50.00 -50.00 1

Offset

Start Freq
On Off

Stop Freq

Sweep Time
Auto Man

a. Res BW is set to 100 kHz, Fail Mask is set to Rel, and Abs Stop and
Rel Stop are both set to Couple.

Selects the offset pairs (upper and lower) that the softkeys
affect, and displays the memory selection menu from A to E
(where you can store up to 5 sets of values for Start Freq, Stop
Freq, Sweep Time, Res BW, Meas BW, Abs Start, Abs Stop, and so
forth). Press Offset until the letter of the desired offset is
underlined. Only one selection at a time is shown on this key
label.

Key access: [[[33] > More > Spectrum Emission Mask > Offset/Limits

Specifies the inner limit (frequency closest to the carrier) for
both segments of the specified offset pair. When Start Freq
(Off) is selected, the offset pair is not measured.

Key access: @ > More > Spectrum Emission Mask > Offset/Limits
Specifies the outer limit (frequency furthest from the carrier)
for both segments of the specified offset pair. The minimum

frequency difference between Start Freq and Stop Freq is limited
to 100 Hz .

Key access: @ > More > Spectrum Emission Mask > Offset/Limits

Specifies the sweep time for the currently selected offset, and
toggles this function between Auto and Manual for each offset.
Key access: @ > More > Spectrum Emission Mask > Offset/Limits
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Res BW
Auto Man

Abs Start

Abs Stop
Couple Man

Rel Start

Rel Stop
Couple Man

Fail Mask

N9320A Spectrum Analyzer

One-Button Measurements 5

Specifies the resolution bandwidth used in measuring the
offset pair. When set to Auto, the Res BW from the default
tables for “Offset/Limits” on page 130 are used. When set to
Man, the allowed range is 1 kHz to 1MHz.

Key access: [[[33] > More > Spectrum Emission Mask > Offset/ Limits

Enables you to enter an absolute level limit at Start Freq for
the currently selected offset ranging from -200.00 to +50.00
dBm with 4 significant digits.

Key access: @ > More > Spectrum Emission Mask > Offset/Limits
> More

Enters an absolute level limit at Stop Freq for the currently
selected offset ranging from -200.00 to +50.00 dBm with 4
significant digits, and to toggle this function between Couple
and Man. If set to Couple, this is coupled to Abs Start to make
a flat limit line. If set to Man, Abs Start and Abs Stop you can
enter different values to make a sloped limit line.

Key access: @ > More > Spectrum Emission Mask > Offset/Limits
> More

Enters a relative level limit at Start Freq ranging from -150.00
to +50.00 dBc with 4 significant digits.

Key access: @ > More > Spectrum Emission Mask > Offset/Limits
> More

Enters a relative level limit at Stop Freq ranging from -150.00
to +50.00 dBc with 4 significant digits, and to toggle this
function between Couple and Man. If set to Couple, this is
coupled to Rel Start to make a flat limit line. If set to Man, Rel
Start and Rel Stop you can enter different values to make a
sloped limit line.

Key access: [[ff5 > More > Spectrum Emission Mask > Offset/ Limits
> More

Displays the menu to select one of the following logic keys
for fail conditions between the measurement results and the
test limits: Absolute, Relative, Abs AND Rel, and Abs OR Rel.

Key access: > More> Spectrum Emission Mask > Offset/Limits
> More > More
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One-Button Measurements

Meas BW

Absolute

Relative

Abs AND Rel

Abs OR Rel

Sets the limit test to show Fail if one offset is
larger than the corresponding limit for Abs Start
and/or Abs Stop. This is the default selection for
each offset for BTS measurements.

Key access: > More> Spectrum Emission Mask
> Offset/Limits > More > More > Fail Mask

Sets the limit test to show Fail if one offsets
spectrum emission mask measurement results is
larger than the corresponding limit for Rel Start
and/or Rel Stop.

Key access: @ > More> Spectrum Emission Mask
> Offset/Limits > More > More > Fail Mask

Set the limit test to show Fail if one offset’s
spectrum emission mask measurement results is
larger than both the corresponding limit for Abs
Start and Abs Stop and the limit for Rel Start and
Rel Stop.

Key access: @ > More > Spectrum Emission Mask
> Offset/Limits > More > More > Fail Mask

Set the limit test to show Fail if one offset’s the
absolute spectrum emission mask measurement
results is larger than the corresponding limit
for Abs Start and Abs Stop or the limit for Rel
Start and Rel Stop.

Key access: @ > More > Spectrum Emission Mask
> Offset/Limits > More > More > Fail Mask

Specifies the bandwidth to use when measuring the offset.
When using the front panel, only the currently selected
offset is affected. All the offsets are affected when remote
control. This is the multiplier applied to the resolution
bandwidth to determine the bandwidth to integrate when
calculating the power. Meas BW is now restricted to be 1
and not changeable.

Key access:

> More > Spectrum Emission Mask > Offset/Limits

> More > More
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6 Instrument Messages

Overview

If an improper operation occurs during the instrument
configuration, an message will appear on the status line.
indicating the incident and the how the spectrum analyzer
corrected the setting automatically. You need to

press > More > Show errors to read the specific

System
descriptions of those messages.

Example

In this example, an explanation is generally included with
each error to further clarify its meaning. The instrument
messages in this guide are listed numerically.

<Code>
-330 Self-test failed <Message>

A self-test failure occurred.

<Explanation in manual>
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Command Errors

N9320A Specturm Analyzer

-100

-101

-102

-103

-104

-108

-109

-110

Instrument Messages 6

The messages listed below are command errors, which are
saved into local registers.

Command error

An unrecognized command or data type was encountered.
This message is used when the device cannot detect more
specifics described for errors -101 to -109.

Invalid character
A syntactic element contains an invalid character.

Syntax error
An unrecognized command or data type was encountered.

Invalid separator
The parser was expecting a separator and encountered an
illegal character.

Data type error
The parser recognized a data element that is not allowed.

Parameter not allowed
More parameters were received than expected for the
header. For example, the *ESE common command only

accepts one parameter, so receiving *ESE 0,1 is not allowed .

Missing parameter

Fewer parameters were received than required for the
header. For example, the *ESE common command requires
one parameter, so receiving *ESE is not allowed.

Command header error

An error was detected in the header. This message is used
when the device cannot detect more specifics described for
errors -111 to -119.
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-112

-113

-128

-130

-131

-134

-138

-144

-148

Program mnemonic too long
The header contains more than 12 characters.

Undefined header

The header is correct in syntax, but it is undefined for this
device.

Numeric data not allowed

A legal numeric data element was received, but the device
does not accept one in this position for the header.

Suffix error

This error is generated when parsing a suffix. This message
is used when the device cannot detect more specifics
described for errors -131 to -139.

Invalid suffix

The suffix does not follow the syntax described in IEEE
488.2, or the suffix is inappropriate for the device.

Suffix too long
The suffix contained more than 12 characters.

Suffix not allowed

A suffix was encountered after a numeric element which
does not allow suffixes.

Character data too long

The character data element contains more than 12
characters.

Character data not allowed

A legal character data element was encountered where
prohibited by the device.
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-200

-222

-223

-224

-241

-253

-300

Instrument Messages 6

The system messages listed below are execution conflicts,
indicating settings conflict during your operation.

Execution Error
This is the generic syntax error for devices that cannot
detect more specific errors.

Data out of range

A legal program data element was parsed but could not be
executed because the interpreted value was outside the legal
range defined by the device. The displayed results may be
clipped.

Too much data not all points entered

Indicates that a legal program data element of block,
expression, or string type was received that contained more
data than the device could handle due to memory or related
device- specific requirements.

Illegal parameter value
An attempt was made to select a user file that contains 0
bits. Select another user file that contains at least 1 bit.

Hardware missing

Missing device hardware. For example, the RF board is not
installed.

Corrupt media

A source media (possibly EEPROM) for a data file is corrupt.
This error is usually seen in conjunction with errors con-
cerning a certain file.

Device-specific error

This is the device-specific error for devices that cannot
detect more specific errors.
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-330 Self-test failed
A self-test failure occurred. Report this error to Agilent

Technologies.
-340 calibration failed

An expected file was not found while trying to load internal
calibration.
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Device-Specific Errors

N9320A Specturm Analyzer

102

104

105

201

204

211

213

214

Set 50 MHz signal < 0 dBm, do alignment again

There is too much 50 MHz energy at the RF port for
alignments to run. Reduce input power to less than 0 dBm
and run alignments again.

1lst LO Unlock

The first LO on has lost phase lock. Report this error to the
nearest Agilent Technologies sales or service office.

2nd LO Unlock

The second LO has lost phase lock. Report this error to the
nearest Agilent Technologies sales or service office.

Option not installed

The desired operation cannot be performed because a
required option is not installed.

TG Frequency Limit

The tracking generator has reached the limit of its allowable
frequency range.

RBW limited to 1 kHz when Span > 1 MHz

In spans greater than 1 MHz, narrow (digital) resolution
bandwidths, below 1 kHz, are not available.

Span limited to 1 MHz when RBW < 1 kHz

In narrow (digital) resolution bandwidths, below 1 kHz,
spans greater than 1 MHz are not available.

TG start freq is less than 9 kHz

Tracking generator uncalibrated below 9 kHz.
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215

224

238

501

502

604

605

610

612

651

TG start freq is less than 1/2 res bw

Tracking generator uncalibrated at start frequencies below
1/2 the current resolution bandwidth.

Option not licensed

The selected option requires a license. Refer to the
installation procedures in the user guide provided for this
particular option.

VBW filter or Average Detector cannot use both

RF over load

Either increase input attenuation or decrease the input
signal level.

IF over load

Either increase input attenuation or decrease the input
signal level.

File already exists

You attempted to save to a file that already exists. Either
delete or rename the existing file or select a new name, then
try again.

Media is protected

A save was attempted to a write- protected device.

File access is denied

The file is protected or hidden and cannot be accessed.

File not found

The analyzer could not find the specified file.

Connect TG OUT to RF IN

Attempt to align the tracking generator without its output
connected. Connect the TG SOURCE to RFIN.
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652

751

752

753

757

758

760

762

764

Instrument Messages 6

Connect CAL OUT to RF IN

you must connect the CAL OUT to RFIN with the appropriate
cable.

Instrument state set to initial wvalues

While trying to load a trace or state, the state information
was found to be in error. This may be because the state had
been stored on a later revision of analyzer firmware. A
default set of state variables was loaded instead. There is
nothing wrong with the analyzer.

Unable to load state from file
Attempt to load a state from a file failed.

Unable to save state to file

Attempt to save a state to a file failed. See the associated
error messages for the cause.

Unable to load user state

A user preset failed, so the factory preset values were used.
Save a valid state into user preset and try again.

Unable to save user state

Attempt to save a user preset state failed.

Unable to query state

Query of state over the remote interface was unsuccessful.

Unable to load file

A failure occurred while loading a file.

Unable to save file

Attempt to save a file failed; the file was not saved.
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767

768

770

780

781

782

783

784

805

Fatal LDS error

Attempt to initialize the instrument state has failed. Cycle
instrument power. If this fails to correct the problem,
contact your nearest Agilent Technologies service center.

Unable to load user state

Attempt to load a state failed, because the state was
saved with a measurement personality that is not currently
loaded. Load the appropriate personality and try again.

Incorrect filename

You sent a remote command to save a screen file but did not
specify a valid extension.

No Peak Found
No signal peak was found that meets the criteria under

| > Search Criteria.

Video Trigger cannot be active
You sent a remote command to do one of the following:

e Turn on video trigger while the Average Detector or a
Marker Function is active.

e Turn on the Average Detector or a Marker Function while
Video Trigger is active.

Video Trigger cannot be used with Mkr Func

Due to the Average Detector, the video Trigger cannot be
used with Maker function.

Allowable span for current CF exceeded
Allowable CF for current span exceeded

Doing Alignment
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This chapter includes information on how to check for a

problem with your spectrum analyzer, and how to contact

Agilent Technologies for service.

Agilent Technologies
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7 In Case of Difficulty

Check the Basics

Before calling Agilent Technologies, or returning an analyzer
for service, perform the quick checks listed below. This
check may eliminate the problem.

¢ Is there power at the receptacle?

¢ Is the analyzer turned on? Listen for internal fan noise to
determine if the analyzer cooling fan is running. Feel the
rear side of the analyzer for air flow.

e If other equipment, cables, and connectors are being used
with your spectrum analyzer, make sure they are
connected properly and operating correctly.

¢ Review the measurement procedures being performed
when the problem first appeared. Make sure all of the
settings are correct.

e If the analyzer is not functioning as expected, return the
analyzer to a known state by pressing > Preset. For
details, refer to “Presetting the Spectrum Analyzer” on
page 27.

¢ Is the measurement being performed, and the results that
are expected, within the specifications and capabilities of
the analyzer? Refer to the Technical Overview for your
analyzer.

¢ Is the analyzer displaying an error message? If so, refer to
“Instrument Messages” on page 135.

* To meet specifications, the analyzer must be aligned. For
more information on how to align the analyzer, please
refer to “Running Internal Alignments” on page 22.

There are no service components in the spectrum analyzer. To
prevent electrical shock, please don’'t disassemble your spectrum
analyzer. Please contact Agilent Technologies or professional
service provider for your service.

146
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Read the Warranty

Agilent Technologies provide one year warranty as standard
for your spectrum analyzer. The warranty information for
your spectrum analyzer is in the back of Technical Overview.
Please read it and be familiar with its terms.

If your spectrum analyzer is covered by a separate
maintenance agreement, please be familiar with its terms.

Agilent Technologies offers several optional maintenance
plans to service your spectrum analyzer after its warranty
has expired. Call the nearest Agilent Technologies sales
office for full details.

If you want to service the spectrum analyzer yourself after
the warranty expires, you can purchase the Service Guide
that provides all necessary test and maintenance
information.
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Contact Agilent Technologies

Agilent Technologies has offices around the world to provide
you with complete support for your source. To obtain
servicing information or to order replacement parts, contact
the Agilent Technologies customer contact center listed
below. In any correspondence or telephone conversations,
refer to your spectrum analyzer by its product number and
full serial number, press > More > Show System

Online help: http://www.agilent.com/find/assist

United State Canada Europe

(tel) 800 829 4444 (tel) 877 894 4414 (tel) +31 20 547 2111
(fax) 800 829 4433 (fax) 800 746 4866

Korea Japan Latin America

(tel) 080 769 0800 (tel) +81 426 56 7832 (tel) +1 (305) 269 7500
(fax) 080 769 0900 (fax) +81 426 56 7840

China Taiwan Australia

(tel) 800 810 0189 (tel) 0800 047 866 (tel) 1 800 629 485
(fax) 800 820 2816 (fax) 0800 286 331 (fax) +61 (3) 9210 5947

Other Asia Pacific Countries

(tel) +65 6375 8100
(fax) +65 6755 0042

E-mail: tm_ap@agilent.com
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Menu Maps

This chapter provides a visual representation of the front
panel keys and their associated menu keys (in Spectrum
Analyzer mode). Refer to Chapter 4, “Key Reference” for key
function descriptions.

The name editor menu is shown separately, though it is
accessed when entering data for many keys. The front- panel
key menus appear in alphabetical order as follows.
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8 Menu Maps

Amplitude Menu

Amplitude
[ J v

Ref Level YAxis | dBm
Units >
Attenuation dBmV
Auto Man
Scale/Div dBuV
Scale Type dBuA
Log Lin
Watts
Volts
More | More Amps
10f2 20f2
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BW/Avg Menu

BW/
Avg

N9320A Spectrum Analyzer

Res BW
Auto Man

Auto

Video BW
Auto Man

Video Avg

VBW/RBW
Auto Man

Pwr Avg

Average
On Off

Avg Type >
Auto Man

Menu Maps

8
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Menu Maps

Det/Display Menu

152

Det/
Display

v
Detector > > Top Auto
Auto Man
Center Positive
Peak
Bottom Negative
Peak
Active Fetn | | Average
Position> Video RMS
Display Line Sample
On Off
Normal
Limits >
v —%
Limit 1 > > Type Point
J Upper Lower
Limit 2 > Limit Frequency
On Off
Test Amplitude
On Off
Margin Connected
On Off Yes No
Edit> |
Delete All Delete Limit Delete Point
Limits
Return Return Return
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File Menu (1 of 2)

N9320A Spectrum Analyzer

Menu Maps 8
’@
| —
y v

Catalog> > By Date All
Save Type> By Name Screen
Load Sort> State
Delete> | Trace
Copy Local Order Limits

Up Down

USB

Return Return
Save Now Delete Now By Date
Type> > Screen Type> By Name

State

Source Trace Source>
Name Limits Name Order
Up Down
Return Return Return
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File Menu (2 of 2)

’@
y v
Catalog Load Now N By Date
Save> Type> By Name
Load> Sort> || State
Delete> Destination> | Trace
Copy> Order Limits
I Up Down
Return Return
a.
v v v
Copy Now By Date All Trace 1 Limit 1
Type> [~ By Name Screen Trace 2 Limit 2
Sort> State Trace 3
Trace Trace 4
Order Limits
Up Down
Return Return

a. The path is depend on the Type selection.
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N9320A Spectrum Analyzer

Center Freq

Start Freq

Stop Freq

CF Step
Auto Man

Signal Track
On Off

Menu Maps

8
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Marker Menu

156

Menu Maps

Select Marker > Freq Counter > Freq Counter Delta
—»| Freq Counter L
1,2,3..12 On Off On Off
Normal Resolution Delta Pair
Auto Man Ref Delta
Delta > | | Phase Noise > |_ Span Pair
Span Center
Off Opti ® Noise
On Off
All Off
Funtion > | |

More Return Return

10of2
Select Marker > . on | bl Phase Noise Offset
1 e On Off -30KHz  30kHz
Marker Trace off Offset Offset
Auto1234 Manual -60KHz 50kHz
Prev Page Offset Offset
-1KHz  1kHz -100KHz 100kHz
Next Page Offset Offset
-10KHz  10kHz -1IMHz 1MHz

Offset
-20KHz  20kHz

Marker Table > |_| More More
10f2 20f2
More Return Return

20f2
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Marker-> Menu

Mkr-> CF

Mkr-> CF Step

Mkr-> Start

Mkr-> Stop

Mkr-> Ref Lvl
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Menu Maps

Measure Menu (1 of 2)

158

v

Measure Off

Channel Power

Occupied BW >

ACP >

More
10f2

Intermod >
(TOI)

Spectrum
Emission Mask

More
20f2

Avg Number X dB Avg Number
On Off On Off
Avg Mode Avg Mode
Exp Repeat Exp Repeat
Max Hold Integ BW
On Off
Occ BW% Pwr Chan Pwr Span
0BW Span
More |g—p More
Return Return Return
| 2
Avg Number Offset
On Off ABCDEF
Avg Mode Method Offset Freq
Exp Repeat IBW RBW On Off
Chan Integ BW Total Pwr/PSD Ref BW
Auto Man
Offset/Limits > || Limits Pos Offset Limits
On  Off
Meas Type Neg offset Limits
Total Pwr PSD
More ¢ More
Return Return

a. Continued on sheet 2 of 2
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Measure Menu (2 of 2)

Measure Off Avg Number Total Pwr Ref | | Chan Integ BW Absolute
On Off
Channel Power Avg Mode PSD Ref Chan Span Relative
R Exp Repeat
Occupied BW > TOI Span Sweep Time Abs AND Rel
Auto Man
ACP > Max Mixer Lvl Res BW Abs OR Rel
Auto Man Auto Man
Total Pwr/PSD
Ref
More
102 Return Return
Avg Number Offset Offset Offset
On Off ABCDEF ABCDEF ABCDEF
Meas Type > Start Freq Abs Start Fail Mask >
On Off
Intermod > Ref Channel > Stop Freq Abs Stop Meas BW
(TOl) Couple Man
Offset/Limits > Sweep Time Rel Start
Auto Man
Spectrum Res BW Rel Stop
Emission Mask Auto Man Couple Man
More PEY More More
10f3 20f3 30f3
More
Return Return Return Return
2 of 2
a. Links to Meas Menu (sheet 1 of 2)
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8 Menu Maps

MODE Menu

160

MODE I
 —

v l l
Spectrum AmplitudeTG Power Sweep Store Ref
Analyzer On Off On Off (1->3)
Tracking Attenuation Normalize
Generator > Auto Man On Off

Amptd Offset Normalize > Norm Ref Lvl
On Off
Amptd Step Tracking Peak Norm Ref Posn
Auto Man
Man Track Adj Ref Trace
View Blank
More More
10f2 20f2
Return Return Return
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Name editor Menu

N9320A Spectrum Analyzer

ABCDEFG

HIJKLMN

OPQRSTU

VWXYZ

Return

Menu Maps

8
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Peak Search Menu

Peak
Search

162

-

Peak Search Peak Max Value
Excursion

Next Peak Peak Excursion

e Threshold & Threshold

Next Pk Right Threshold
Hidden

Next Pk Left Peak Search
Type >

Min Search

Pk-Pk Search

More Return

10f2

Continuous Pk Peak Table
On Off On off
N dB Points Peak Sort
On Off Freq Amptd
Search
Criteria >

Peak Table >

More Return

20f2
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Preset/System Menu

Preset/
System

N9320A Spectrum Analyzer

Menu Maps

v

Preset

Alignment>

Align (Ext Cable)

Power On
Last Preset

Pwr on/Preset

Preset Type> |

>
Alignment > Save User
Preset
Language> Timebase
Load defaults CAL OUT
On Off
Diagnostics>
More Return Return Return
10f3
‘ ¥ .
Show System English User
Show Hardware Factory
Show Software
Show Errors> Front Panel Test
Time/Date>
More Return
20f3
| v !
Licensing > Option Time/Date Prev Page
On Off
License Key Date Format Next Page
MDY DMY
Activate Set Time
License
Brightness Set Date
Sevice Clear error
Queue
More Return Return
30f3 Return

8
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8 Menu Maps

SPAN Menu

Full Span

Span

Zero Span

Last Span
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Sweep/Trig Menu

N9320A Spectrum Analyzer

Sweep/
Trig

Sweep Time Free Run
Auto Man
Sweep Video
Single
Sweep External Pos
Cont

External Neg
More More
10f2 20f2

Menu Maps

8

165



8 Menu Maps

View/Trace Menu

View/
Trace J ¢
Select Trace > » Trace 1
1
Clear Write Trace 2
Max Hold Trace 3
Min Hold Trace 4
View
Blank
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Numerics

10 MHz REF OUT, 8
3GPP W-CDMA, 130
802.11a, 131
802.11b, 132

A

Abs Start, 133
Abs Stop, 133
AC power receptacle, 8
Active Fctn Position, 80
active function, 6
adjacent channel power, 123
Agilent Technologies,contact, 148
Alignment, 109

running, 22
Amplitude key, 3,70
annotation,marker, 28
annotations,display, 6
Attenuation, 70
attenuation,reducing, 39
Auto Tune key, 4,73
Average, 76

Back, 74
BW/Avg key, 4,75

c

CAL OUT connector, 5
Catalog, 85

CE mark, 9

Center Freq, 91

CF Step, 91
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channel power, 118
comparing signals
off screen, 32
on the screen, 30
connector
CALOUT, 5
EXTTRGIN, 8
PROBE POWER, 5
REF IN, 8
REF OUT, 8
RFIN, 5
TG SOURCE, 5
USB, 5,8
VGA, 8
Continuous PK, 104
Copy, 89
CSA mark, 9
c-tick mark, 9

D

Data control keys, 4
Delete, 88

delta marker, 93
Det/Display key, 4,78
Detector, 78

Display, 6

Display Line, 80, 81
distortion,measuring, 47

E

Enter key, 84

error message, 21

ESD, 19

EXT TRG IN(TTL), 8
external reference, 22, 23

F

factory preset state, 108
Fail Mask, 133
File key, 85
File/Print key, 4
firmware revision, update, 23
frequency counter, 95
Frequency key, 3
front panel
display annotations, 6
overview, 3
symbols, 9
front panel,using, 26

H

harmonic distortion
measuring, 47

improving frequency resolution and
accuracy, 43

instruction manual, 9
instrument messages, 135
Int Preamp, 71

10 libraries suite, 24
ISM1-A, 9

L

LAN, 8
Licensing, 112
Limits, 81
Load, 87
Local, 4

lock, 8
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M

Marker key, 4, 93
Marker Table, 96
Marker-> key, 4, 97
Max Mixer Ivl, 127
Meas key, 4,98, 117
measuring
ACP, 123
channel power, 118
disortion, 47
distortion, 47
low-level signal, 39
multiple signals, 30
occupied BW, 120
SEM, 128
source’s frequency drift, 45
TOI, 50, 126
measuring phase noise, 53
menu maps, 149
messages, 21
Min Search, 104
MODE key, 4,99

N

N dB Points, 104
Next Peak, 103

0

occupied BW, 120
Offset/Limits, 124, 130
options, 12
enable, 22
licensing, 112
TG3, 5
order list, 12

P

Peak Search key, 4, 103
Peak Table, 106

Phase Noise, 95

phase noise,measuring, 53
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power cord, 13
power receptacle, 8
power requirements, 13
power switch, 8
Preset, 107
preset

factory, 27

user, 27
Preset/System key, 4, 107
PROBE POWER, 5
Pwr on/Preset, 109

rack mount, 16

rear panel overview, 8

REF IN, 8

Ref level, 70

REF OUT, 8

Rel Start, 133

Rel Stop, 133

remote control, 24

requirements
ventilation, 15

Res BW, 75

resolving signals
equal amplitude, 34
hidden by large signals, 37

RF IN connector, 5

S

Save, 86

Scale/Div, 70

Search Criteria, 104
Show System, 110
Signal Track, 92
softkeys, 3

SPAN key, 3,113
spectrum emission mask, 128
standby switch, 5
Start Freq, 91

Stop Freq, 91
Sweep/Trig key, 4, 114

switch
power, 8
standby, 5

symbols, 9

T

TG SOURCE connector, 5
Threshold Hidden, 105
TOI
Meas key, 126
measuring, 50
TOI Span, 127
tracking drifting signals, 45

U

USB
DEV, 8
host, 8
using frequency counter, 43

v

VBW/RBW, 75
ventilation, 15

VGA, 8

Video BW, 75
View/Trace key, 4,116
viewing signal, 27

W
WEEE, 9
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